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1 Course Builder Overview

1.1 Application Overview

The course builder is a Java application that allows users to build a training course out of different kinds of course elements.  These components include assignable units, blocks, prerequisite requirements and completion requirements.  Assignable unit is a formal term for a schedule lesson.  A block is a group of these assignable units.  The user can add these course elements to a course being edited and define prerequisite and completion conditions by visually manipulating their graphical representations in the Course Builder application.  The following is a picture showing what the main interface of this application looks like:
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Figure 1
This application is very similar to a flowcharting tool in appearance.  The user define when course elements may be taken, when they are considered complete and what the lessons are composed of.  This is basically defining a “course flow” or the sequence in which the course is run.

The application takes as input either a set of empty course export files (specified in Appendix A), or a set of non-empty course export files.  If the course files are empty then the Course Builder assumes the course is a new one.  If the course files are non-empty, then the Course Builder assumes it is modifying an existing course.  The Course Builder needs to parse these files and present the content in its course builder window.  After the user is finish modifying the course, the Course Builder needs to re-export the information back to the same set of ASCII files.

The Course Builder is cross platform due to Java and can be localized to various languages.

1.2 Course Overview

The unit of training that the Course Builder application works with is a course.   A course is made up of a number of course elements.  They are assignable units and blocks.  An assignable unit is the smallest unit of training that can be assign to the student in this system.  In a real world example, this would be something like a lecture, a homework assignment, or an exam.  You can think of an assignable unit as any training material about a single topic that can be finished in one session.  A block is a group of these assignable units.  It is mostly a convenience structure whose benefits become apparent when prerequisite and completion requirements are introduced a little later in this section.

Before explaining what an assignable unit is, we must first define a new element called a lesson.  A lesson represents a piece of training material that can be finished within one session.  In the course builder, it can be one of three types:  web based, instructor based, and CMI compliant CBT based.  The last type of lesson is any computer based training courseware that conforms to a certain protocol for controlling lesson behavior and gathering performance information.   Examples of lessons include a single lecturer of a university course, a courseware CD, or a web course.  The training content represented by a lesson is not course specific  and can be reused in different courses.

The assignable unit(AU) is the course specific instance of a lesson.  In contains customization information such as time, location, and grading options.  The assignable unit is only valid inside a course.  When building a course, the user inserts a new assignable unit by selecting an existing lesson or creating a new lesson to go with the assignable unit.  Then the user can enter the customization information for the AU.   There are common properties between the AU and Lesson.  The AU’s property value always overrides the lesson’s property values since it is a customization.  There is always a one-to-one correspondence between AUs and lessons.

An example of the assignable unit/lesson relationship is as follows:

A lesson called “Java Syntax” teaches about the syntax of Java and is taught over the web in the form of a video.  It appears in two assignable units in two different courses.  One assignable unit is live and taught from 7:00 a.m. to 8:00 a.m. in the course “Java For C++ Programmers” for a grade.  Another assignable unit is prerecorded and can be taken at any time.  It is in a different course named “Java For Dummies”.  There is no grading option associated with this course.   The assignable unit/lesson distinction allows the customization of time and grading option in this case. 

In the user interfaces, all assignable units are referred to as lessons mostly for the user.  It is much easier for the user to just associate with one type of object rather than two.  For the specification, it is important to make the distinction because of how the information is stored and managed.

To control the flow of training through the different assignable units in a course, we introduce the concept of prerequisite and completion requirements.  Prerequisite requirements specify what must be completed before a student can start an assignable unit.  The completion requirements specify under what conditions, the assignable unit is considered to be complete.

Finally, the block course element is a group of assignable units and is treated as a single assignable unit for prerequisite and completion conditions.  This means, for example, students must satisfy the prerequisite condition defined for the block before they can take any of the assignable units inside the block.  

Course structures and elements are further discussed in section 2.

1.3 Feature Overview

The following is a list of its features along with a brief description.  Each feature will be discussed in detail in later sections when the user interface associated with the feature is specified.  They are divided into system features and graphical development features.

1.3.1 System Features

Complex Prerequisite Definition Capability

A user can define complex prerequisite conditions using various logic operators.

Complex Completion Requirement Definition Capability

A user can also define complex completion requirements using the same logic operators as in prerequisite conditions.

Ability to Use Exising Lesson To Compose Courses

The user can compose a course out of existing CBT training material.  They can also use an existing instructor led lessons in multiple courses.

Easy to Add New Course Elements

The architecture allows for addition of course element other than AU and Block easily.

1.3.2 Graphical Development Features

These features are available when visually developing a course in the Course Builder.

Snap to Grid

All objects can be snapped to a set of gridlines for uniform placement.

Auto-Layout

The Course Builder can automatically place course elements for the user according to their prerequisite chain or time line.

Easy Prerequisite Wiring

The user can define simple prerequisite requirements by laying wires from and to assignable units.   The user can easily customize the wiring layout. 

Completion Requirement Wiring

The same for prerequisite wiring applies to completion requirement wiring.

Complete Layout Control

The user has complete layout control of all course elements and wiring. 

Multiple Zoom Levels

There are three zoom level for viewing larger courses all in one screen.

Find Feature

For large and complex courses, the Find feature allows the user to quickly locate a course element.

2 Course Structure & Course Elements

2.1 The Course 

2.1.1 Course Overview

A course is composed of various course elements.  They are: 

1. Assignable Unit
Also known as an AU, this element represents a scheduled unit of training that can usually be completed in one sitting.  Each AU has all of the information necessary to execute the training content stored in its corresponding lesson object.  For example, a single lecture, a CBT courseware CD, a test or a one day seminar can all be an AU.

2. Block
A group of AU’s.  The block is treated as a single AU for prerequisite and completion requirement purposes (prerequisite and completion requirements are explained later).

Each course element can have prerequisites and completion requirements. Each course can only have completion requirements.  Each course element also has its own unique system ID within the course generated by the Course Builder.

The simplest course is a single AU.   For example, a simple course “Introduction to Java” only has a single AU with the title of “Java Introduction”:

[image: image6.wmf]100%


Also, this course can have a simple completion requirement that equates the completion status of the course to the completion status of the AU.  This means whatever the student gets for the AU is what he gets for the course.  If the student passes the AU then he passes the course.

A slightly more complex course is made up of multiple AUs connected together by prerequisite conditions. For example, the following course is made up of three different AUs with IDs of A1, A2, A3 connected in sequence as follows:
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The black arrows represent prerequisites.   It says that the student must pass A1 before he can take A2 and he must pass A2 before he can take A3.  The content of each AU can be from very different sources.  For example, A1 can be a CBT courseware, A2 can be an instructor led training session, and A3 can be online examination.  The user can also add completion requirement to this course.  For example, he can state that the completion status of AU A3 is equivalent to the completion status of the course.  This would essentially make A3 a final exam for this course.

The user can also group multiple AUs into a Block (another type of course element).  The Block is treated as a single AU for prerequisite and completion requirement definitions.  Once the student has satisfied the prerequisite for the Block, he can take any of the AUs within the Block in any order.

The definition of prerequisites is very flexible.  The user can use logic operators such as AND, OR, and NOT together with AU and block IDs as operands.  The definition of completion requirements is similar to prerequisites in that it is also made up of a series of logical statements; however, the operands are slightly different.  This will be covered in detail later on in this section.

2.1.2 Course Properties

All of the course elements and course structures are fully described in a set of Course Export Files.  The format of these files is completely specified in Appendix A. 

2.2 Course Examples

In this section, two example courses are given to illustrate the various course elements and course structure components.

2.2.1 Example Course I

The following is an example introductory course on Java:
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Figure 2
In this diagram, a course is made up of 7 assignable units.  Three of the AU’s are organized into a block.  The black arrows represent the prerequisite information for each course element.  The prerequisite condition states the student must first complete “Introduction to OO Programming” before attempting “The Java Language”.  After the “The Java Language”, the student as a choice to taking “Java Applets” or “Java Applications”.  Once “Java Applications” is complete, the student can then take the “Java Packages” block.  This means, the student can take any of the AUs within the block in any order. 

The completion requirement is not illustrated in this example; however, a few valid completion requirements are the following:

(1) The Course’s completion status = Pass IF  Block B1’s completion status = Complete

(2) AU A4’s completion status = Complete IF AU: A3’s completion status = Complete

Completion requirements are defined in detail in a later section.

2.2.2 Example Course II


The following is a more complex example:
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Figure 3
In this example, there are a total of 10 assignable units.  The prerequisite requirement is marked by black arrows.  The student can start from any of the 3 course starting points because these three AUs do not have prerequisites.  In the case of assignable unit A10, the lesson has a more complex prerequisite that is a combination of AU’s A12 and A9.  The following are some of the valid prerequisite conditions for A10:

(1) A9’s completion status = Pass AND A12’s completion status = Pass

(2) A9’s completion status not = Fail AND A12’s completion status = Complete

In the illustration AU A10 is blown up to illustrate what happens during the execution of the training content.  It shows all of the different completion statuses that a course element may have:  “Not Attempted”, “Incomplete”, “Complete”, “Fail”, and “Pass”.

“Not Attempted” means the student has not yet started the AU.  “Incomplete” means the student is currently taking the AU.  “Complete” means the student has seen all of the material for the AU. “Fail” means the student has not achieved a passing score and “Pass” means the student has exceeded the passing score.

2.3 Course Properties

The following is a list of course properties.   The user may edit these properties from the “File => Properties” menu option.  Each property corresponds to a keyword in the COURSE.CRS file.  The properties that are marked [optional] may not have the keyword appear in the COURSE.CRS file.  In this case, you should use the default value for those properties.  

Course Property List

Property Name: creator
COURSE.CRS: 
Course_Creator keyword

Default:
None.  Required Field.

Description:
This property identifies who created the course.  This property is not editable.

Property Name:
ID

COURSE.CRS: 
Course_ID keyword

Default:
None.  Required Field.

Description:
This is the unique course ID for the course. This property is not editable.

Property Name:
systemVendor
COURSE.CRS: 
Course_System keyword

Default:
“Training Software”

Description:
This is the name of the predominant authoring tool that created the course.
Property Name:
title

COURSE.CRS: 
Course_Title keyword

Default:
The value of the ID property.
Description:
This is the commonly used name for the course.  
Property Name:
homePage

COURSE.CRS: 
Home_Page keyword [optional]

Default:
blank.

Description:
This is the home page of the course description.  
Property Name:
level

COURSE.CRS: 
Level keyword

Default:
3 

Description:
hard coded to 3.  This property is not editable    
Property Name:
location

COURSE.CRS: 
Location keyword [optional]

Default:
Generated from the location property of all of its AUs.  
If all of the AU’s have the same location (blank locations do not count) then this property will contain that location.  Otherwise, it will contain the string “Multi-Location”.  If all of the location properties are blank then this property will be blank. 

Description:
This is the predominant location where the course takes place.  By default it is calculated from the location property of all of the course’s AU’s.  
Property Name:
startTime

COURSE.CRS: 
Start_Time keyword [optional]

Default:
The value of the earliest startTime property in the member AU’s.
If no such value exist then time 0. 

Description:
This is the time when the first scheduled AU in the course starts.  It can be changed by the user.
Property Name:
endTime

COURSE.CRS: 
End_Time keyword [optional]

Default:
The latest value of the endTime property in all member AUs.
If no such value exist then 0. 

Description:
This is the time when the course is planned to end.  The user can change this value.  If no startTime exist (startTIme=0) then the endTime is like a due date.
Property Name:
maxScore

COURSE.CRS: 
Max_Score

Default:
100   

Description:
The maximum score that a student can get on the course.  This is purely an informational property.  
Property Name:
maxEnrollment

COURSE.CRS: 
Max_Enrollment keyword [optional]

Default:
999999 

Format:
positive integer 

Description:
The maximum number of students that can be enrolled in the course.  This property restrict the size of the enrollmentList property.
Property Name:
instructor

COURSE.CRS: 
Instructor keyword [optional]

Default:
blank 

Description:
The Course Builder will just read it in from the export files and write it out when it is saved.  This property is not editable. 
Property Name:
description

COURSE.CRS: 
The [Course_Description] group.  

Default:
Blank

Description:
This is the expanded description of the course.  It is usually 1 short paragraph long.
2.4 Course Element

The course is made up of a number of course elements.  So far, the course elements are:  the Assignable Unit and the Block.  They both have the following common properties:

Property/Method Name
Description
Format

systemID
Each course element has a unique id relative to the course they are contained in.  The format of the systemID depends on the type of the course element.  For assignable units, the id starts with the letter ‘A’.  For blocks, the id starts with the letter ‘B’.

DEFAULT: Generated by the Course Builder when the course elements are created.
UNIT_ID[A|B]

title
The title for this course element.  

DEFAULT:  if the course element is an AU, the title is the title of the lesson that belongs to the AU.  Otherwise, it is blank.
TEXT

max 254 chars.

description
A description for this course element.  

DEFAULT: if the course element is an AU, the description is the description property of the lesson that belongs to the AU.  Otherwise, it is blank.
TEXT

2.5 Assignable Units

The assignable unit is the basic building block of a course and is the first course element type.  An assignable unit represents the smallest unit of training that can be assigned to a student.  It contains course specific information about the training content such as the start and end times, the location, and the maximum score.  They do not have any meaning outside of the course.

The following is a list of assignable unit properties in addition to those listed under Course Elements.

Property Name
Description
Format

homePage
The home page for this AU.  This property is optional.

DEFAULT: blank.
URL 

location
The location where this AU is to take place

DEFAULT: blank
STRING

startTime
The starting time of the AU.  If no starting time is given then the student can start it anytime.

DEFAULT: 0 or blank (no start time)
DATE_TIME

endTime
The ending time of an AU.  If there is no ending time, then there is no deadline or a time when the AU must finish.  If there is only an end time and no start time, then the end time property functions as a due date.

DEFAULT: 0 or blank (no deadline)
DATE_TIME

lesson
The lesson associate with this course.  Referenced by an internal ID.  See Lesson description in a later section.
Reference to a lesson.

The following properties exist in the lesson as well.  These properties allow the user to change the training content’s default behavior to suit a particular course.

masteryScore
Overrides the masteryScore property in the lesson object associated with this AU.

DEFAULT: The lesson’s masteryScore property value
UINT

maxTimeAllowed
Overrides the maxTimeAllowed property in the lesson associate with this AU. 

DEFAULT: The lesson’s maxTimeAllowed property value.
TIME

timeLimitAction
Overrides the timeLimitAction property in the lesson object associated with this AU.  Applies only to CMICompliantCBTLesson object.

DEFAULT: Exit, Message
{ “Exit”, “Continue”, “Message”, “No_Message” } 

[comments]
AU specific comments made by the instructor.  There can be multiple comments per AU. 
TEXT

Every assignable unit has a lesson associated with it.  A lesson represents the course independent training content and contains parameters that affect how the training content is executed.   A single lesson object can be associated with multiple AU’s.  This allows the reuse of training material in different courses.  For example, the lesson “Java AWT” can appear in an AU in the course “Introduction to Java” and in another course “Mastering JFC”. 

The lesson will be discussed in a later section.

2.6 Blocks

A block is a group of AUs.  A block’s prerequisite applies to all of the AU’s contained inside the block.  This means, if the block’s prerequisite is not satisfied, none of the AUs in the block can be executed. 

Blocks do not have any special properties other than the membership information.  The following is a description of that membership information:

Property Name
Description
Format

[Members]
The list of member AU’s belonging to this block.  Each AU is identified by its systemID property here.

DEFAULT: at least 1 AU.
A list of systemID’s.

The unique system ID of a block begins with the letter ‘B’ and is followed by an integer.  For example, B1, B2, and B125 are all proper ID’s.

2.7 Lessons

The lesson is a reusable unit of training content.  It can be used in multiple assignable units within different courses as the same time.   Currently there are three concrete lesson types: instructor-led, CMI Compliant CBT, and Web based lessons.  More types may be added in the future so the architecture must be modular and expandable.  Both the CMI Compliant CBT and Web based lessons derive from the CBT Lesson abstract type.  How each lesson is launched and how the performance data is collected distinguish the different types.  Their class hierarchy is as follows:
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Figure 4
At the leaves of this class tree are the three available lesson types in the prototype system.  They are:

1. Web based CBT lesson 
This is the non-CMI compliant web based lessons.  Lessons of this type are executed by pointing a web browser to a starting URL.  There is no performance data that can be collected.

2. CMI compliant CBT lesson 
This lesson type can be executed through a defined set of protocols.  Performance data can also be collected through a set of data files.

3. Instructor-led Lesson
This lesson type is the traditional class room lesson.  There is no way to execute it on the local workstation.  An information panel describing when and where to take the class is given by the CMI system when executed.

All of the lesson objects are accessed through the LessonManager interface class defined in LessonManager.java.  No implementation is provided.  In order to test the Course Builder fully, you must implement a quick and dirty version of LessonManager interface.

IMPORTANT

The Java classes for this hierarchy and LessonManager has been defined fairly completely.  You may not modify the existing method definitions. You may not extend these class either.  If problem in implementing the needed features under these rules, you must notify me immediately before attempting to make any changes. 

2.7.1 The BaseLesson Object

This is the root class for all Lesson objects.  It contains the common properties among all different types of lessons.

Basic Lesson Properties

Property Name
Description
Format

ID
Unique internal system ID for the lesson.  It is used for a fast reference and is has redundant functionality to the combination of vendorID and systemVendor properties.
ALPHAN_ID

title
Commonly used name for the lesson.  Such as “Java AWT classes”.

DEFAULT: the ID
STRING  Maximum 254 characters

description
A textual description of the content of the lesson.  

DEFAULT: blank.
TEXT

type
User definable type string.  

DEFAULT: One of “Web”, “Training Software”, “Instructor Led” depending on the lesson type.  “Training Software” corresponds to the CMICompliantCBT Java type.
STRING

[keywords]
Keywords associated with the lesson.  Used for searching lessons.

DEFAULT: none.
List of STRING

maxScore
The maximum score a student can get in the lesson

DEFAULT: 100
UINT

masteryScore
If a students gets >= this score then he/she is considered to have passed the lesson

DEFAULT: 50
UINT

systemVendor
The author of the lesson.  This and the vendorID property uniquely identifies a lesson.

DEFAULT: Training Software.
STRING  

vendorID
An ID given by the creator of the course.  This and the systemVendor property uniquely identifies a lesson.  

DEFAULT: Same as the ID field..
ALPHAN_ID

The BaseLesson class has already been defined in the BaseLesson.java file. 

2.7.2 CBT Lesson 

The CBT Lesson type is a special case of the basic lesson.  It represents all computer based training lessons or courseware.   It does not have any extra properties but the meaning of the vendorID and systemVendor fields are different:

CBT Lesson Properties

Property Name
Description
Format

vendorID
An internal ID generated by the developer of the CBT lesson.
ALPHAN_ID

systemVendor
The name of the company or vendor who developed this CBT lesson.
STRING  

The CBTLesson class has already been defined in the  CBTLesson.java file.  

2.7.3 Web-Based CBT Lesson

This type of lesson is the non-CMI compliant variant of web lessons.  It is completely taught on the web.  It can be referred to by a URL such as http://www.trainingsoft.com/courses/C15. 

The following are data properties for this type of lesson.  They are in addition to the basic lesson data properties described above and not modifiable inside an AU.

Property Name
Description
Format

URL
The url of the lesson.

DEFAULT: Blank
STRING

This class has already been defined in WebLesson.java.  

2.7.4 CMI Compliant CBT Lessons

This type of lesson corresponds to a CMI compliant CBT lesson.  CMI compliant means that there is a predefined way the CBT lessons should be launched.  There is also a predefined format through which returned performance data is collected.  In the Course Builder, you do not have to worry about these particular features.  You just have to be able to:

(1) create a CMI Compliant CBT Lesson object.

(2) Identify such a lesson when it is returned by the LessonManager and allow the user to modify its properties

Each CMI compliant CBT lesson type contains the following data properties.  The default value applies when a new CMI Compliant Lesson object is created.

Property Name
Description
Format

coreVendor
Parameters needed to launch the CBT lesson.   It will be passed as an execution parameter in the execution interface.   

DEFAULT: blank
TEXT

commandLine
The execution command to launch the CBT lesson.  It is a shell command to start the lesson.  This is for command shell launch of the lesson only.

DEFAULT: blank
STRING



fileName
The full identifier of the file containing the most critical content of the lesson.  Should not include an explicit path name.

DEFAULT: blank
STRING

Case sensitive.

maxTimeAllowed
The maximum amount of time allowed for the lesson.  

DEFAULT: 2:00:00
TIME

timeLimitAction
The action to be taken when time has expired according to maxTimeAllowed.  This property is modifiable in an AU.  Exit and Continue are mutually exclusive.  Message and No_Message are mutually exclusive.

DEFAULT: Exit, Message
{ “Exit”, “Continue”, “Message”, “No_Message” } 

This class has already been defined in the CMICompliantLesson.java file.  

2.7.5 Instructor-led Lessons

This is the traditional instructor-led classroom lesson.  In this lesson type, the vendorID and systemVendor has different meanings. 

“Instructor-led Lesson” custom type.

Property Name
Description
Format

vendorID
The same as the title of the lesson.
ALPHAN_ID

systemVendor
The same as the lecturer field below
STRING  

lecturer
The person who is lecturing or teaching this lesson.  
STRING

lecturerInfo
Information about this lecturer
TEXT

This class has already been defined in the InstructorLedLesson.java file.

2.8 Prerequisite & Completion Requirement Overview

Prerequisite and Completion requirements apply a course-flow structure to the course elements.  They control when the student can take a particular AU or Block and when completion status they should have.  Prerequisite conditions are used to control entry into a course element.  If the prerequisites are not satisfied, then the course element can not be started by the user.  Completion conditions are used to alternatively determine the completion status of a course element.  It is used primarily to state equivalence relations between different course elements.  For example, completing one course element is the same as completing another course element.  These conditions are especially useful in course elements that function like equivalence tests or proficiency tests.

All of these condition are defined using special logic statements discussed later in this section.  The operand of these logic statements is the completion status of a course element in the form of (<Course Element system ID> = <completion status).  The system ID is exactly the same as the systemID property in section 2.4.  The completion status is one of “Complete”, “Incomplete”, “Fail”, “Pass”, or “Not Attempted”.

Completion status is the status after a student has executed the training content associated with a course element.  It also applies to the course as well.  In the Course Builder, you only need to be concerned with the ability to define such condition and export them to the file structure specified in section A.5 and section A.6.  You do not have to worry about the inner workings of these conditions.  These explanations are only to help you understand the conditions easier.

An example of a prerequisite condition is:

A8, A7=P & A6 != F

In this example, the student is not allowed to start the AU A8 until AU A7 is passed and A6 does not have a fail status.

2.9 Logic Statements

The following are the possible logic operators:

Symbol
Operator Meaning
Example

&
AND.  
A1 & A2

|
OR
A1 | A3

never
Never
A34, never, F 

~
Not
~B1

{ }
Group of set.  Usually used in conjunction with the * operator.
{ A1, B1 }

,
Separator for members of a set {}
{ A1, B1 }

*
Complete X members out of a set
3 * {A1, A2, A3, A4, B1}

complete 3 out of the 5 course elements

( )
Evaluate first.  
B2 | (3 * {A1, A2, A3, A4, B1} * & B1)

The operand of the logic statement is in the following format:

<system id(section 2.4)> = <course element status>

The course element status can be either P(Pass), C(Complete), F(Failed), I(Incomplete), or N(Not Attempted).  The operand can also be abbreviated by using only the system ID instead of <system id> = <course element status>.  In this case, it is the same as requiring a “Complete” status for that AU. The following is an example:

A3, ~(B2=F) & A1=I & A2, Pass

In this example, AU A3 will get a “Pass” status if:

Block B2 is not Fail AND AU A1 is Incomplete AND A2 is complete.

Notice that by default, if only the system ID is show in the operator (like A2 in the example above), the operand is assumed to read <system id>=C.

The Java class PerformanceRecord in PerformanceRecord.java represents the completion status of a course element or course.

2.10  Prerequisites

Prerequisite conditions define the entry condition of an assignable unit or block.  All of the prerequisite conditions must be satisfied in order for the student to be able to start an assignable unit.  If the conditions are for a block, then none of the AUs within the block can be started without satisfying the prerequisites.  Each AU or block can have multiple prerequisite conditions.  

The simplest prerequisite definition is a singular dependency.  This means, the prerequisite of an AU ‘B’ is the passing of another AU ‘A’:  the student may start AU ‘B’ only after he or she has passed AU ‘A’.  An example of a singular dependency prerequisite appears in Figure 2 where a black arrow illustrates the relationship.  

Each prerequisite condition has the following format in the course export files:

<course element systemID>, <Prerequisite Logic Statement>

Example 1: A31, A23 & A28

The student is required to complete A23 and A28 before beginning AU A31.

Example 2: B31, ~(A31=F)

The student is required to not have failed A31 in order to begin block 31.

Example 3: A5, 1*{A1, A2, A3, A4=P}

The student is required to have completed one of A1, A2, A3 or passed A4 in order to start AU A5.

More examples are available in Appendix A.

Validity of Prerequisites

A prerequisite condition is valid if the following conditions are met:

· The syntax of the prerequisite statement is correct.

· The prerequisite logic statement does not contain the system ID of the target course element(circular dependency).  The following is an invalid statement:
A1, A1=P

· All of the systemsIDs refer to a valid course element in the course.

2.11  Completion Requirements

Completion requirements define how to determine the final status of a course element or the course. There may be multiple requirement conditions for each course element or course.  The requirement condition that appears first has a higher precedence.

Each statement is made up of three properties.  The first property, “systemID”, defines the course element or course that this requirement applies to (the target element).  The second property, “Requirement”, is the logic statement describing the dependency.  The third property, “status”, is the new status of the course element or course if the logic statement returns TRUE.  The semantics of each requirement statement is:  

If  “Requirement” = TRUE then “systemID” status = “status”

The properties for each completion requirement is as follows:

Property Name
Description
Format

systemID
The system id of the course element.  This is the same as the systemID property for each of the AU or block.  If the system ID is “Root” then it refers to the course.
UNIT_ID[A|B]

or

“Root”

Requirement
The logic statement as described in section 2.9.
STRING

Maximum of 1000 characters

status
This can be one of:

· Complete

· Incomplete

· Not attempted

· Pass 

· Fail

Only the first letter of each status is significant
{ 

“Complete”, “Incomplete”, 

“Not attempted”, 

“Pass”, 

“Fail” 

}

Example 1:  “B13”, “A23=P & A24=P & AJ25=P & A26=P”, “Complete”

B13 is considered complete anytime when objectives A23, A24, A25, A26 are passed.

Example 2:  “B13”, “A8=P | A9-P | A10-P | A11=P”, “Incomplete”


“B13”, “A8=P & A9=P & A10=P & A11=P”, “Complete”

In this bad example, B13 will never be considered to be complete since the first condition always true before the second.

Example 3:  “B13”, “A8=P & A9=P & A10=P & A11=P”, “Complete”

 
“B13”, “A8=P | A9=P | A10=P | A11=P”, “Incomplete”

This fixes the problem in example 3.  Now B13 will be considered complete when AU’s 8,9,10, and 11 are all passed.  It will be considered incomplete when one to three of those AU’s are passed but not all 4.

More examples are available in Appendix A.

Validity of Completion Requirements

A completion requirement condition is valid if the following conditions are met:

· The syntax of the condition is correct.

· The completion requirement statement does not contain the system ID of the target course element(circular dependency).  The following is an invalid statement:
A1, A1=P, Pass

· All of the systemIDs refer to a valid course element in the course.

3 Physical Specification

3.1 Physical Structure and “Dimensions”

Basic Requirements

Platform
Windows 95/98, NT Workstation, NT Server

GUI size
<= 800x600 pixels.  Resizable window.

Language
Java 1.1X

Application Type
Java Application

Development Environment
· No AFC (Microsoft’s Application Foundation Classes)

· Use JFC

Memory Requirement
<= 32 MB on the system.  See below for application memory limit.

Machine Speed
233 MHz Pentium

Disk Requirement
None

Network Requirement
None

Localization
Primary language: English

Secondary language: Chinese

Important Environment Variables:


%TS_PATH% -  The root installation path of the training software packages 

Installation Paths:

Command Line
C:> %TS_PATH%\COURSE_BUILDER\BIN\Course_Builder.BAT
    <Directory where course export files are located>

Configuration File Format: None

Application Memory Usage Target:


<= 3 MB for the base application +


0.5k / (Course Element, Prerequisite, and Completion Requirement)

3.2 Input and Input Conditions

The input of the Course Builder is as follows:

C:> <Course Builder Executable> <Fully Qualified Path>

Argument
Description

1.  Course Builder Executable
%TS_PATH%\COURSE_BUILDER\BIN\COURSE_BUILDER.BAT

2.  Fully Qualified Path
This path specifies where to find the course files describing a course to be modified.  All course files begins with COURSE and is followed by an extension describing what it contains.  The format of these files are described in Appendix A.  They are:

COURSE.CRS
The Course File 

COURSE.AU
The Assignable Unit File
COURSE.DES
The Descriptor File

COURSE.CST
The Course Structure File

COURSE.PRE
The Prerequisites File

COURSE.CMP
The Completion Requirements File

COURSE.LYO
The Course Layout  File [ Optional ]

The Course Builder should parse the course files to load the course to be edited.  The following two cases can be true for the input course:

(1) The course may be empty if the Total_AUs keyword has the value 0.
The Course Builder is creating a new course all other files except for COURSE.CRS may be ignored.  Assume that the course is empty.

(2) The course is non-empty if the Total_AUs keyword has the value > 0.   
The Course Builder is modifying an existing course.  

If no COURSE.LYO file exists, you may assume that the course is being loaded into the Course Builder for the first time.  

3.3 Output and Output Conditions

The user can finish the execution of the Course Builder in the following two cases:

(1) The user quits and has saved the course being edited with changes
The Course Builder will export the new course to the same set of input files.  This action overwrites the original input files.  In this case, the course’s location, startTime and endTime property should be generated from its AU’s properties of the same name.

(2) The user quits without ever saving or quits with no changes to the course
The Course Builder will remove all of the course input files.


3.4 Localization

The Course Builder should be localized to Chinese and English.  English must be the primary language.  I will give you the localization architecture after milestone 1 has been completed.  Once you receive the localization architecture, you should use it to localize the application.

4 User Interface

4.1 Overview

The main screen of the course builder interface is shown below: 


Figure 5
The screen is divided into four main regions.  They are:

· The Window Frame

· The Menu Bar

· The Toolbar

· The Main Work Area

In the following sections, each of these sections will be discussed.

4.2 The Window Frame


The window frame is very similar to a regular Windows Application’s window frame.  The title of the frame is the following string:

Course Builder: <Course’s Title Property>

The course title is the Course_Title keyword value imported from the course files.

It also comes with the standard shrink window, restore window and close window icons on the top right hand corner.


4.3 The Main Work Area

The main work area is the part of the screen where the course is constructed.  It looks like the following:

The picture above illustrates the main work area.  The main work area is framed inside a scrollable panel with horizontal and vertical scrollbars.   The area visible in the scrollable panel is called the visible work area.  The main work area refers to complete area necessary to display the course.  This may include parts not displayed in the visible work area.

Definition: Visible Work Area

The area show in the scrollable panel.

Definition:  Main Work Area

The complete work area including what is not shown in the scrollable panel.

The possible GUI object that appear in this window are:

· Course Start Bar
This bar represents the beginning of the course.  AU’s and Blocks that are taken “earlier” in the course appear toward the Course Start Bar. 

· Course End Bar
This bar represents the end of the course.  AU’s and Blocks may relate their completion statuses to the course’s completion status.

· Work Area Elements:
These are elements used to construct a course.  They are:
(1) Assignable Unit 
(2) Block
(3) Prerequisite Line
(4) Completion Requirement Line
(5) Prerequisite Block
(6) Completion Block

· Element pop-up menu
This pop-up menu appears if the user right clicks on a work area element.

· Element Property Window
This window display all of the properties of a particular work area element.

The work area has the following properties:

· The work area can be zoomed at 100%, 65% and 50% resolutions.  Each work area element has a correspondingly size icon for each of those resolutions.

· Clicking and dragging on an empty space will allow the user to drag a rectangle.  When the mouse is released, all items within the rectangle are selected.  

· The user may press Ctrl while selecting items.  This action will add to the existing selection.

4.3.1 Course Start Bar

The Course Start Bar represents the start of the course and is located to the left most side of the main work area. 

There will be a prerequisite line from the Course Start Bar to all AU or Blocks that do not have prerequisite conditions.  As soon as a prerequisite condition is defined for that AU or Block, this line disappears.

The Course Start Bar can be scrolled off of the visible work area.

4.3.2 Course End Bar

The Course End Bar represents the end of the course and is located to the bottom most side of the main work area.  It can be scrolled out of the visible work area.   This bar is used to associate course elements whose completion status affect the completion status of the course.  All such course elements should have a completion requirement line (orange-yellow) from its Completion Requirement block to the Course End Bar.

Right clicking on the Course End Bar will bring up the completion requirement property window for this course.  The user can then modify the completion requirements from this window. 

4.3.3 Work Area Elements

Each work area elements represent a part of the course.  It can either be a course element or a course structure component.  The following are all of the possible work area elements:

(1) Assignable Unit
This GUI component represents an assignable unit within the course.  

(2) Block
This GUI component represents a block within the course.

(3) Prerequisite Block
This GUI component represents a set of prerequisite conditions involving more than 2 course elements.

(4) Prerequisite Line
This GUI component is a line that illustrate a prerequisite relationship between 2 elements.  

(5) Completion Requirement Block
This GUI component represents completion requirement conditions and the completion status of a course element.  It is always associated with a course element and appears to the immediate right of that course element

(6) Completion Requirement Line
This GUI component represents a completion requirement relationship between two course elements.  It must connect 2 completion requirement blocks.

For each work element there are 3 different resolutions.  Each resolution corresponds to 100%, 65% and 50% magnification.  At each resolution, different information is displayed.

4.3.3.1 Assignable Unit

The assignable unit work area element is an icon representing an assignable unit course element discussed in section 2.5.   

Icons

The following is the assignable unit at different resolutions.  The dark gray box to the right is the completion requirement block described in a later section.


Res.
Size
Size w/ Completion
Primary Display
Secondary Display

100%
112 x 75 pixels
128 x 75 pixels
“<Assignable Unit’s system ID>: <title property>”

Up to 2 lines.  Fit within the box or truncate the text.

Font: Helvetica, size 12
An information box 100 x 38 pixels.

Font: Helvetica, size 8

What is display can be changed in the options menu.

65%
75 x 50 pixels
85 x 50 pixels
“<Assignable Unit’s system ID>: <title property>”.  Fit in the box or truncate the text.

Font: Helvetica, size 11
None.



50%
45 x 30 pixels
51 x 30 pixels
Assignable Unit’s systemID property.

Font: Helvetica, size 12
None

Creating Element

This component is created from the following places:

(1) Menu: Insert => Web Lesson or Instructor Led Lesson or AICC 2.0 Compliant Lesson

(2) Toolbar: Icons in the insert lesson toolbar submenu

Left Click On Icon

Left click on this icon will select the assignable unit and highlight it in green.

Right Click On Icon

Right clicking on this icon will bring up the pop-up menu discussed in section 4.3.5.  You are expected to use the JFC’s built-in pop-up menu features.

Click and Drag On Icon

The user can click on this object and drag it around the work area.  If the “Snap to Grid” is turned on, then the icon will be moved only on grid boundaries.  All prerequisite lines and completion requirement lines are moved with the object.

Delete Icon

The following warning dialogue box will appear before the icon is deleted:

 

The default button is the “Cancel Delete” button.  If cancel delete is selected, nothing will occur.  If Delete is clicked, the AU is deleted from the course.  All incoming prerequisite lines are deleted.  All outgoing completion lines are also deleted.  For a list of prerequisite and completion requirement conditions deleted, please see the Cut Icon section.

Cut Icon

If a cut operation is performed on the icon, the icon is removed from the work area and placed in the clipboard.  All of its incoming and outgoing lines are cut with the icon.  The following is a list of the prerequisite and completion requirements that are cut with the icon.  It is broken down into 5 cases:

(1) Incoming prerequisite line
All prerequisite conditions with X as the target course element are cut.

(2) Incoming completion requirement 
All completion requirements with X as the target course element are cut.

(3) Outgoing prerequisite line to a Prerequisite block
All prerequisite conditions in the Prerequisite block whose operand has only X is cut.

(4) Outgoing prerequisite line to a Course Element Y.
All prerequisite conditions that has Y as the target and X as the only operand in the prerequisite condition are cut.

(5) Outgoing completion requirement line to course element Y’s completion requirement block
All completion requirements with Y as the target and X as the only operand in the completion requirement condition are cut.

Copy Icon

If a copy operation is performed on the icon, the user will be asked if they want to create a new version of the assignable unit with everything the same except for the system ID.  The new AU is then placed inside the clipboard.  A new AU must be created in this case to prevent duplicate AUs with the same system ID from appearing in the course.

Paste Icon

When the assignable unit is pasted, the icon is removed from the clipboard and placed in the visible work area.  All prerequisite and completion requirement lines are updated.

Output Generated When Course Builder Exits

A number of output lines will be generated in different course files when the course builder exits for each assignable unit.  The following is a list:

In COURSE.CRS:

The Total_AUs keyword will reflect the total number of AUs in the main work area.

In COURSE.AU:

One line will be generated for each AU in the COURSE.AU file.  Please see the description of this file in Appendix A for more details.

In COURSE.DES:

One or more lines will be generated for each AU in the COURSE.AU file.  Please see description of this file in Appendix A for more details.

In COURSE.CST:

For every AU that does not belong to a block, its system ID will appear in the “root” line of the course structure file.  Please see Appendix A for more details.

4.3.3.2 Block

The Block work area element is an icon representing a Block course element described in section 2.6.  Remember that a Block is nothing more than a group of assignable units.  

Icons

The BSlock has the exact same dimensions as the assignable unit except its icon is different.  The following is the Block icon at different resolutions:


Res.
Size 
Size w/ Completion
Primary Display
Secondary Display

100%
112 x 75 pixels


128 x 75 pixels
“<Block’s system ID>: <title property>”

Up to 2 lines.  Fit within the box or truncate the text.

Font: Helvetica, size 12
“<# of AU’s> Lessons”

Property in an information box 88 x 13 pixels.

Font: Helvetica, size 8

65%
75 x 50 pixels
85 x 50 pixels
“<Block’s system ID>: <title property>”.

Fit in the box or truncate the text.

Font: Helvetica, size 11
None.



50%
45 x 30 pixels
51 x 30 pixels
Block’s systemID property.

Font: Helvetica, size 12
None

Creating Element

This component is created from the following places:

(1) Menu: Insert => Block

(2) Toolbar: The block icon in the Insert submenu of the toolbar.

Left Click On Icon

Left clicking on this icon will select the block and highlight the icon in green.

Right Click On Icon

Right clicking on this icon will bring up the pop-up menu discussed in section 4.3.5.  You are expected to use the JFC’s built-in pop-up menu features.

Click and Drag On Icon

The user can click on this object and drag it around the work area.  If the “Snap to Grid” is turned on, then the icon will be moved only on grid boundaries.  All prerequisite lines and completion requirement lines are moved with the object.

Delete Icon

The following same warning dialogue box will appear in this case as for the assignable unit case.  The default button is the “Cancel Delete” button.  If cancel delete is selected, nothing will occur.  If Delete is clicked, the block and all AU’s inside the block are deleted from the course.  All incoming and outgoing completion lines are deleted.  For a list of prerequisite and completion requirement conditions that are deleted, please see the Cut Icon section below. 

Cut Icon

If a cut operation is performed on the icon, the icon is removed from the work area and placed in the clipboard.  All incoming and outgoing lines are cut with the icon.  The prerequisite and completion requirement conditions are cut depending on the situation below.  In these situations, X refers to the system of the icon to be cut:

(1) Incoming prerequisite line
All prerequisite conditions with X as the target course element are cut.

(2) Incoming completion requirement 
All completion requirements with X as the target course element are cut.

(3) Outgoing prerequisite line to a Prerequisite block
All prerequisite conditions in the Prerequisite block whose operand has only X is cut.

(4) Outgoing prerequisite line to a Course Element Y.
All prerequisite conditions that has Y as the target and X as the only operand in the prerequisite condition are cut.

(5) Outgoing completion requirement line to course element Y’s completion requirement block
All completion requirements with Y as the target and X as the only operand in the completion requirement condition are cut.

Copy Icon

If a copy operation is performed on the icon, the user will be asked if they want to create a new version of the block with everything the same except for the system ID.  The new block is then placed inside the clipboard.  A new block must be created in this case to prevent duplicate blocks with the same system ID from appearing in the course.  

Paste Icon

When the block is pasted, the icon is removed from the clipboard and placed in the visible work area.  All prerequisite and completion requirement lines are updated.  

Output Generated When Course Builder Exits

For every block, the following lines will be generated in the course export files:

In COURSE.CRS:

· Under Total_Blocks, the total number of blocks will be generated

In COURSE.DES:

The following entry will be generated:


“<Block’s system ID>”,””,”<Block’s title property>”,”<line number X of the title>”,”<Xth line of the block description>”

There will be a number of lines equal to the number of lines in the block’s description property for each block.  There is a maximum of 254 characters per line.

In Course.CST:

The following entry will be generated for each Block:

“<Block’s system ID>”,…The System ID’s of each of the AU’s belonging to the block…

The system ID of each of the AUs belonging to the block is separated by a comma.  

Also, the Block ID will appear with the “Root” line of the COURSE.CST file. 

Please see the COURSE.CST file description in Appendix A.

4.3.3.3 Prerequisite Line

The prerequisite line illustrates a prerequisite relationship between course elements.  The line is blue colored like the prerequisite block.  The starting point is always from the right side of a completion requirement block or the right side of a prerequisite block.  The end point is either the left side of a prerequisite block or the left side of a course element icon.  The line has the following meaning:

“The source course element is an operand in a prerequisite condition whose target is the destination course element.”

For example, the following are all cases of prerequisite lines.

Case I:  Course Element To Course Element

In this case, there is only a singular dependency for the prerequisite conditions.  For example, only prerequisite conditions of the following form in the COURSE.PRE file are represented by this case:

<Source Course Element’s system ID property>, <Statement containing only the destination Course element’s system ID property>

In the above example, if “Introduction To OO Programming” has a system ID of A1, “Java Packages” has a system ID of B1, and “Quick Tour of Java Packages” has a system ID of A2.  The following set of prerequisite conditions will be generated in the COURSE.PRE file when the course builder exits:

B1, A1=P

A2, A1

Some definitions:

Defintion: Target Course Element

This refers to the course element referenced by the left most system ID(before the comma)in a prerequisite or completion requirement condition.  For example:

<Target Course Element’s systemID>, <logic statement> [, <status>]

Definition: Source Course Element
The course element whose ID appear as an operand in a prerequisite or completion requirement condition’s logic statement.  It is usually the left endpoint of a prerequisite or completion requirement line.

Definition: Destination Course Element

Another word for the target course element.  It is one of the endpoints of a prerequisite or completion requirement line.  It usually appears on the right end of such a line.

Creating Element

To wire two course element blocks, the user must have chosen the prerequisite line tool in the toolbar.  He must then first click on the source course element (the one on the left end of the prerequisite line).  At this point, the user can drag the prerequisite line, which is shown as it is been dragged.  After the user clicks on the destination course element (the course element on the right end side of the prerequisite line), the line will be laid out according to the layout behavior specification in section 4.3.6.   Slide 12 and Slide 13 in the Course Builder Specifications power point slide illustrates the actions.

The default prerequisite condition generated (in the COURSE.PRE file) by this action is:  

<Source Course Element’s systemID>, <Desination Course Element’s systemID> 

Case 2: Course Element To Prerequisite Condition To Course Element.


Prerequisite conditions appear when the prerequisite for a certain course element becomes more complicated than what is illustrated by the just the prerequisite line.  It is automatically inserted if more than one prerequisite line is attached to a target course element (A2 in the illustration above).  If the user attempts to attach more prerequisite lines to a course element that already has a Prerequisite Block preceding it, the line is attached to the Prerequisite Block instead of the course element.  The newly attached prerquisite line will be dashed until its source course element is actually used as an operand inside the prerequisite condition.   The prerequisite’s property window will also pop up to allow the user to edit the new conditions.

For example, in the above case, lets say the line between “JFC” and Prerequisite Block did not yet exist.  The user can use the prerequisite line tool to attach a prerequisite line between the “JFC” course element and the prerequisite block.  At this point, the line will show up as a dashed 

blue line because the user has not yet defined how to use the course element “JFC” inside the prerequisite condition.  At the same time, the prerequisite block property window will pop up on the right side of the visible work area.  This allows the user to reedit the prerequisite conditions to include the course element “JFC”.  Once it is included, the dashed blue line will become a solid blue line.

In this case, selecting the prerequisite line will pop up the prerequisite property window for the prerequisite block.

There can only be 1 prerequisite line between any two work area element at a time.

Left Click on Line

Left clicking on the line will select the line and highlight the line with small rectangles at all line segment endpoints as follows:

Right Click on Line

Right clicking on this icon will bring up the pop-up menu discussed in section 4.3.5.  You are expected to use the JFC’s built-in pop-up menu features.

If the “Properties” option is chosen, it will bring up the prerequisite property window.  All prerequisite conditions that have the source course element as an operand and the destination course element as the target is displayed.  Please see the “Prerequisite Property Windows” slides in Course Builder Specifications.ppt for more details.

Click and Drag Line

Please see the layout behavior section (section 4.3.6) on how the user can modify the wiring.

Delete Line

The following warning dialogue box will appear before the icon is deleted:

The default button is the “Cancel Delete” button.  If cancel delete is selected, nothing will occur.  If Delete is clicked, the prerequisite line is deleted.  

In case 2, if the prerequisite conditions inside the prerequisite block becomes invalid, the prerequisite block will flash. 

Cut Icon

A prerequisite line can not be cut.

Copy Icon

A prerequisite line can not be copied.

Paste Icon

A prerequisite line can not be pasted.

Generated Output When Course Builder Exits

In case 1, for every prerequisite line going into course element A to course element B, the following line in the COURSE.PRE file will be generated:

<system ID of A>, <prerequisite condition>

Remember, the default condition is: <system ID of A>, <system ID of B> ; however, the user may have changed it by left clicking on the prerequisite line and editing it through the prerequisite property window.

In case 2, please see the next section.

4.3.3.4 Prerequisite Block

The prerequisite block represents one or more prerequisite conditions.  It is used to represent complex prerequisite conditions.  Complex conditions are prerequisite conditions whose logical statements has more than one course element’s systemID as its operand.

Icons

The following is the prerequisite icon at different resolutions:


Res.
Size 
Display

100%
56 x 38 pixels


“Prerequisite” rotated to the right 90 degrees.  Font: Helvetica, size 12

65%
38 x 25 pixels
“Prereq.” Rotated to the right 90 degrees.  Font: Helvetica, size 12

50%
23 x 15 pixels
“Prereq.” Rotated to the right 90 degress.  Font: Helvetica, size 10

This icon represents a set of prerequisite conditions.  The user can apply this set of prerequisite conditions to one or more course elements by using prerequisite lines discussed in the next section.  Also, all course elements whose completion status appear as operands in the prerequisite condition logic also has a prerequisite line going into the prerequisite block from that course element.

Error Conditions

In the following error conditions, the prerequisite block will flash blue.  

(1) One or more of the system ID’s in the prerequisite condition becomes invalid (when the AU is deleted).

(2) There are no outgoing lines from the prerequisite block.  This happens when the prerequisite conditions have no course element to apply to.

Creating Element

This component is created from the following places:

(1) Menu: Insert => Prerequisite

(2) Toolbar: The prerequisite icon in the Prerequisites submenu of the toolbar.

(3) When a course element goes from 1 to more than 1 incoming prerequisite lines, a prerequisite block is created and placed to the immediate left of the course element.  The previous incoming lines goes into the left side of the new prerequisite block.  An outgoing prerequisite line from the right side of the prerequisite block to the left side of the course element  is created as well.  

Creation method #3 deserves more elaboration.  The situation is as follows:


Adding a new prerequisite line from “Quick Tour of Java Packages” to the “Java Packages” block will insert a prerequisite block immediately to the left of the “Java Packages” block.  The previously incoming line into the “Java Packages” block will be rewired to go into the left side of the new prerequisite block.  The new incoming prerequisite line will be routed to the left side of the new prerequisite block as well.  The following is the resulting configuration


Left Click On Icon

Left clicking on the prerequisite block will highlight its icon in green and select it.

Right Click On Icon

Right clicking on this icon will bring up the pop-up menu discussed in section 4.3.5.  You are expected to use the JFC’s built-in pop-up menu features.

If the “Properties” menu option is chosen, all prerequisite conditions represented by the prerequisite block will be displayed in the prerequisite property window.

Click and Drag On Icon

The user can click on this object and drag it around the work area.  If the “Snap to Grid” is turned on, then the icon will be moved only on grid boundaries.  All prerequisite lines are moved with the object.

Delete Icon

The same dialogue box for prerequisite line will appear.  The default button is the “Cancel Delete” button.  If cancel delete is selected, nothing will occur.  If Delete is clicked, the prerequisite block is deleted along with all of the prerequisite lines.  All incoming prerequisite lines are deleted.  All outgoing prerequisite lines are also deleted.  The prerequisite conditions associated with the deleted objects are removed.

Cut Icon

The prerequisite block is removed from the visible work area.  All prerequisite lines coming in and going out of the prerequisite block is also removed.  All of this information is placed in the clipboard.

Copy Icon

Copy of prerequisite blocks is not allowed

Paste Icon

The prerequisite block is pasted into the visible work area.  All incoming and outgoing prerequisite lines are redrawn according to the layout scheme.

Generated Output When Course Builder Exits

For every outgoing line from the prerequisite block to a course element X, the following lines will be generated in the COURSE.PRE file:

<system ID of X>, <prerequisite condition 1 in the prerequisite block>

<system ID of X>, <prerequisite condition 2 in the prerequisite block>

…

4.3.3.5 Completion Requirement Block

The Completion Requirement Block element represents one or more completion requirements associated with a single course element.  If a completion requirement block is associated with course element A, it will represent all completion requirements of the form:

<system ID of A>, <logic statement>, <status>

in the COURSE.CMP file.

Icons

Each completion requirement icon always appear attached to the right side of the course element it is associated with.  The following are all possible configurations of the completion requirement block: 



The above diagrams illustrate the completion requirement block appearing with its course element at all three resolutions.  The following table defines the dimensions of the completion block:

Res.
Size 
Display

100%
16 x 75 pixels
“Completion” rotated to the right by 90 degrees.: Helvetica, size 10

65%
10 x 50 pixels
None

50%
6 x 30 pixels
None.

The color of the completion requirement block is always dark grey.

Creating Element

The Completion Block is always visible.

Left Click on Completion Block Icon for Course Element A

This will select the Completion Block Icon and highlight it in green.

Right Click on Completion Requirement Icon for Course Element A

Right clicking on this icon will bring up the pop-up menu discussed in section 4.3.5.  You are expected to use the JFC’s built-in pop-up menu features.

If the Properties option is chosen, this will bring up the completion requirement window (Slide 11 of the Course Builder Specifications PowerPoint document) for the Completion Block Icon.  All of the completion requirement conditions that have the associated course element as the target will be displayed in this window.

Click and Drag Icon

This has the same effect as clicking and dragging the course element icon.

Delete Icon

The same warning dialogue box will appear in this case as the one for assignable unit.  The default button is the “Cancel Delete” button.  If cancel delete is selected, nothing will occur.  If Delete is clicked all completion requirements conditions that references this course element will be deleted.

Cut Icon

All of the completion requirement conditions are copied into the clipboard.  The completion conditions are also deleted from the current course element.  The target course element of the completion requirement is not copied.  For example, if the completion block has the following completion conditions:

A1, A2=Pass, Pass

A1, A2=Fail, Fail

These conditions will be copied into the clipboard as:  X, A2=Pass,Pass  and X, A2=Fail,Fail, where X is a variabe. See the Paste Icon action for an explanation.

Copy Icon

The same as cut except the completion conditions are not deleted from the associated course element.

Paste Icon

A course element must be selected for this to work.  If no course element is selected, the following error dialogue box will appear:

If a course element, say A,  is select, the completion conditions in the clipboard will be added to its existing completion conditions.  The variable X will be replaced with the system ID of A.

Generated Output When Course Builder Exits

For every completion requirement block associated with course element X, the following lines will be generated in the COURSE.CMP file:

X, <completion requirement 1>, <status 1>

X, <completion requirement 2>, <status 2>

…

All completion requirements represented by the completion requirement block will be outputted like above.  Please see the COURSE.CMP section in Appendix A for more details.

4.3.3.6 Completion Requirement Line

A completion requirement line from course element A’s completion requirement icon to course element B’s completion requirement icon signifies the following completion requirement condition line in the COURSE.CMP file:

B, <some completion requirement condition involving A>, <completion status>

In other words, the line has the following meaning:

“The source course element is an operand in a prerequisite condition whose target is the destination course element.”

Icon

Completion requirement lines are always colored organe-yellow.  These lines only run from one completion requirement icon to another completion requirement icon.  The following illustration shows how the completion requirement line is connected.  The exact format does not need to be followed; however, the requirement that they run from completion requirement icon to completion requirement icon should be observed.


Creating Element

Completion requirement lines can be created by using the completion requirement tool in the toolbar.  The same wiring technique applies here as for the prerequisite wiring technique. 

There can only be a maximum of one completion requirement line between any two course elements.

Left Click on Completion Requirement Line

Left clicking on the completion requirement line that runs from course element A to B will select the line.  When selected, the line will show small rectangles at all line segment endpoints at either end like the following:

Right Click on Completion Requirement Line

Right clicking on this icon will bring up the pop-up menu discussed in section 4.3.5.  You are expected to use the JFC’s built-in pop-up menu features.

If the “Properties” option is selected, the completion requirement property window will show up.  All completion requirements of the form:

<destination course element system ID>, <logic statement containing source course element’s ID>, status

are shown inside the property window.

Click and Drag on Completion Requirement Line

This has the same effect as clicking and dragging a prerequisite line. 

Delete Icon

The same warning dialogue box will appear in this case as the one for assignable unit.  The default button is the “Cancel Delete” button.  If cancel delete is selected, nothing will occur.  If Delete is clicked, the completion requirement line will disappear.  If this causes the course element at either end to not have any more completion requirement lines coming in or going out of it, that course element’s completion requirement icon will disappear.

Cut Icon

A completion requirement line can not be cut.

Copy Icon

A completion requirement line can not be copied.

Paste Icon

A completion requirement line can not be pasted.

Generated Output When Course Builder Exits

See the output for Completion Requirement Block. 

4.3.4 Element Property Windows

By right clicking on one of the work area elements and choosing the “Properties” menu option, an element property window should pop up inside the visible work area on the right side.  Each of the work area elements has its own element property window.

Please refer to the Powerpoint file Course Builder Specification’s Slide 1 through Slide 11 and Slide 17 for the descriptions.  The following is a reference:

Property Windows
Slide #

Assignable Unit Property Window
Slide 1 through Slide 4

Block Property Window
Slide 5 through Slide 6

Prerequisite Block & Line Property Windows
Slide 7 through Slide 10

Completion Requirement Block & Line Property Windows
Slide 11

Course Property Window
Slide 17

4.3.5 Pop-up Menu

The pop-up menu appears when a user right clicks on a work area element.  The pop up menu is shown on Slide 16 and Slide 21 of the Course Builder Specification PowerPoint document.  The following are its menu options:

Cut

This performs the same action as the”Edit => Cut” menu option.

Copy

This performs the same action as the “Edit => Copy” menu option.

Add Editable Point [Only when right click is performed on a line]

This action adds a editable point to the line segment at where the mouse cursor was when the right click was done.

Properties

This will bring up the work area element’s property window.

4.3.6 Work Area Layout Behavior

This section describes the general rules under which icons and lines are to be drawn.  Your layout algorithm should adhere to these rules.  If you encounter difficulty in achieving these objectives, please contact me and we can discuss the issue.

The layout information is exported to the COURSE.LYO file described in Appendix A when the course is saved.

The layout behavior for icons and lines in the work area can be divided into two cases.  They are:

· Custom layout behavior without snap-to-grid

· Custom layout behavior with snap-to-grid

The custom layout behavior is the default behavior.  It allows user to place icons anywhere in the work area.  Prerequisite and completion lines will be drawn according to the user’s placement of the icons.  With the snap-to-grid feature turned on, the user can only place icons in 10 pixels intervals.  Without this feature, the user can place the icons in 1 pixel intervals.

You will need to write an algorithm that draw the lines accordingly. In this section, we will discuss only the custom layout behavior. 

Before we get into the behavior specification, we must first define a few terms:

Definition: Icon

An icon is one of the following:  

· Prerequisite Block (section 4.3.3.4)

· Completion Requirement Block (section 4.3.3.5)

· Assignable Unit (section 4.3.3.1)

· Block (section 4.3.3.2)

Definition: Line

A line is an unbroken series of pixels.  A line can have a number of Editable Points that denote a break in the line.  The editable points can be moved to create a jagged line.  Each of the two end points of the line is always attached to an icon.  .

Definition: Line Segement

A continuous line segment whose endpoints are the editable points of a line.  The line is made up of line segments 

Definition: Cross Over

The intersection of two lines or line segments.

Definition: Destination Endpoint

The endpoint of a line that is attached to the target of a prerequisite or completion requirement statement.  The target is defined as follows:

<target system ID>, <prerequisite or completion condition> [, status]

Definition: Source Endpoint

The endpoint of a line that is attached to an icon that is an operand of a prerequisite or completion condition.  

The following is an example of a line:



Icon Layout

The user can place icons anywhere in the visible work area including on top of another icon.  The most recently moved icon is always at the top.

The Completion Requirement Block icon is always attached to the right border of an AU or a Block icon.  There should be no spacing between the two icons.  It must always be lined up perfectly in its vertical direction with the AU or Block icon it is associated with.

Drawing Lines: General Rules

These rules apply only if the “Show Prerequisite” => Lines option is selected.

1. The two endpoints of any line is always attached to an icon.

2. The two endpoints may never be attached to the same icon.

3. A line can never be attaching an AU or Block icon with its associate Completion Block icon.

4. When dragging and dropping icons, all prerequisite and completion lines are visually updated as the icon is being moved.  In this case, they can be diagonal lines (a straight line between 2 icons).

5. All wire layout algorithms should layout the lines using horizontal and vertical lines ONLY.  No diagonal lines are allowed.  Only the user can create diagonal lines by dragging the editable points.

6. The wire layout algorithm should not overlap parallel lines.

7. On the average, the algorithm should generate no more than 50% crossovers.  This means if there were 100 prerequisite lines and completion lines, the algorithm should generate no more than 50 crossovers on the average. 


Prerequisite Line Layout

The prerequisite lines must obey the following additional rules:

1. The destination endpoint must be attached to the left border of the icon that is the target of the prerequisite condition. 

2. The source endpoints must be attached to one of the two following places:

· The right border of a completion requirement block.  This AU or Block associated with the Completion Requirement Block must be an operand of the prerequisite condition.

· The right border of a Prerequisite Block icon. 

The following is an illustration of these restrictions.  The valid destination endpoint attachment points is illustrated with a thick solid black line.  The valid source endpoint attachment area is marked with a thick dotted line.

Completion Line Layout

The layout of completion requirement lines must follow these rules:

(1) The source endpoint must be attached to the same places as where the prerequisite requirement’s source endpoint must attach.

(2) The destination endpoint must attach to the top or bottom border of the target course element’s completion requirement icon.  The following is an illustration.


The valid source endpoint attachment location is marked by a think dotted black line.  The valid destination endpoint attachment location is marked by a think solid black line.

User Inputs

The user should be able to change the layout pattern of the lines by the click-and-drag method.  This method is defined as follows:

(1) The user first selects a line to modify by left clicking on the line.

(2) The user then locates the editable point he/she wants to move.

(3) The user left clicks and holds on that editable point

(4) The user can then move the editable point and thereby change the line segments whose endpoints contain the editable point.

Please Slide 21 of the Course Builder Specifications PowerPoint document for a story board of how this is done.

In addition, the user may also add an editable point by right clicking on a line in the place where the new editable point is to be added.  A pop-up menu will then appear.  The user can choose the “Add Editable Point” option in the pop-up menu to add a new editable point.  For an illustration of this process, please see Slide 21 of the Course Builder Specification PowerPoint document.

4.4 The Menu Bar


The menu bar has following main choices:

· File: Where save and quit options are located

· Edit: Where the usual cut, paste, copy, delete options are located

· Insert: Allows the user to insert various kind of course elements and structures into the Main Work Area.

· Tools: Various course construction tools.

· Options: Various display and editing options

· Help: The help texts are located here.  Currently empty.

The complete hierarchy of the menu system is as follows.  All underlined characters are the shortcut keys when the menu is active.  Certain menu items also have global shortcut keys activated by the control key plus another key.  These items can be accessed anywhere in the main work area.

The main menu items have shortcut keys that are activated by pressing Alt + the underlines character at the same time.

Please see Slide 18 and Slide 19 of the Course Builder Specification PowerPoint document for the GUI specifications for these menu items.

4.4.1 File Menu

The File Menu contains the following three items:

Save
Shortcut: Ctrl+S

This option saves the currently edited course to the course export files.  If the course has not changed then no save should be done.  Before saving all error conditions must be fixed. If the error checker does not return a pass status then the save operation is aborted.Please see the notes below on this subject. 

Save and Exit

This option saves the currently edited course to the course files.  This action will overwrite the course export files that were used to read in the course.  If the file has not changed then no save should be done.  If the course has not been modified at all, the course export files should be deleted on exit. Before saving all error conditions must be fixed.   If the error checker does not return a pass status then the save and exit operation is aborted.  Please see the notes below on this subject.

Special Note About Saving

Whenever the user tries to save the course, the course error checker will be invoked.  If the error checker returns a Pass status then a save is done.  Please see section 6.1 for a detailed description on the Course Error Checker Tool.  Otherwise, the following error dialogue is shown:


Exit

This item exits the Course Builder.  If the course has been modified and not saved, the following dialogue should appear to warn the user:


The default selected option should be “Cancel Exit”.  If the user clicks on this option, the Course Builder does not exit.  If the user clicks on “Exit and Don’t Save” option, the Course Builder exits without saving the latest changes.  If the course has never been saved before then the Course Builder should remove the course files that were used as input.

Properties

This option will bring up the property window for the course.  The property window is shown on Slide 17 of the Course Builder Specification PowerPoint document.  In this window, the user may edit the course’s properties.

4.4.2 Edit Menu

The Edit Menu contains the following items:

Undo
Shortcut: Ctrl+Z

This option is triggers the undo of the last action.  When disabled, “Undo” is printed in light gray and the option can not be selected.  Please see section 6.2 for more details

Redo
Shortcut: Ctrl+Y

This option is triggers the redo of the last undone action.  When disabled, “Redo” is printed in light gray and the option can not be selected.  Please see section 6.2 for more details

Cut
Shortcut: Ctrl+X

This is the standard cut feature that exists in almost all windows applications.  It will move an existing screen element into a clipboard.  The following screen elements can be cut:

· AssignableUnit

· Block

· Prerequisite block 

· All highlighted text in text fields.

· Completion Requirement block.

Please see the individual work area element description for a specification on the actions performed in this case.

Copy
Shortcut: Ctrl+C

This action will copy the item in the clipboard to the main work area.  The following are all of the possibilities:

· AssignableUnit

· Block

· Prerequisite block

· All highlighted text in text fields.

· Completion Requirement Block.

Please see the individual work area element description for a specification on the actions performed in this case.

Paste
Shortcut: Ctrl+P

This action will paste the object in the clipboard to the work area.  The following are the valid objects and their behavior when pasted:

· AssignableUnit

· Block

· Prerequisite Block

· Text
The text can only be pasted into another text field.  The text will remain in the clipboard unlike the above three object types.

· Completion Requirement Block

Please see the individual work area element description for a specification on the actions performed in this case.

Delete
DEL

This item will remove the selected work area element or elements.  The behavior is described under each of the work area element in the previous section.


Delete All

This will delete all work area elements.

Find
Ctrl+F

This feature allows the user to goto a course element in the work area.  When this option is selected, the window shown on Slide 15 of the Course Builder Specifications Powerpoint file will appear.

The “Find By:” field selects which property to perform the find on.  The valid choices are:

(1) System ID

(2) Title

(3) Description

(4) Location

The “Search Field” is where the user enters the keywords.  This field is treated as a list of keywords with white-space or ‘,’ being the keyword separator.  

Results are ranked by how many of the keywords are contained in the field specified by the “Find By:” property.  The result with the most matches is ranked highest.

After the user clicks on the “Search” button, the “Results” panel will list the search results ordered by their rank from greatest to least.  If the user selects one of the results by clicking on the item, the visible work area will center on the icon for that AU or block.

When a course element is selected, the visible work area will center on the selected course element. 

The window will close when the “Close” button is hit.

4.4.3 Insert Menu

The Insert Menu contains the following items:

Web Lesson, Instructor Led Lesson, AICC 2.0 Compliant Lesson

These menu items inserts a blank lesson of the appropriate type.  The lesson icon is then selected and centered in the work area.  The lesson’s property window is displayed.  The user can then edit the lesson from the property window.

Note:  This will be replaced by a lesson creation wizard in Part 2.

Block

Inserts an empty block icon.  The block icon is selected and centered in the work area.  The block icon’s property window is displayed.

Prerequisite

The basic prerequisite window shown in Slide 7 of the Course Builder Specifications Power Point document will be displayed.  All fields are empty.  After the user enters a proper prerequisite and clicks the ”Okay” button, the appropriate prerequisite line will be created.  If the user switched to the advanced screen and entered prerequisites that depend on more than 1 AU or for more than 1 AU, the appropriate prerequisite block will be created.  

If the user cancels the operation, no prerequisite requirements are added.

Completion Requirement 

The completion requirement window shown in Slide 11 of the Course Builder Specifications Power Point document will be displayed.  All fields start off empty.  After the user enters proper completion requirements and clicks “Okay”, the appropriate completion requirement lines are drawn.

If the user cancels the operation, no completion requirements are added.

4.4.4 Tools Menu

This menu contains several tools that help the user to build course.  They are:

Error Checker

This option will invoke the course error feature.  Please see section 6.1 for more details.

4.4.5 Options Menu

The Options Menu contains items that are mostly on/off type of options.  

Show Prerequisites ( Lines

All of the prerequisite conditions will be shown as prerequisite lines.  These lines are described in section 4.3.3.3.

Please see section 4.3.6 for more details.  By default, this option is selected.

Show Prerequisites ( Highlights

The prerequisite lines will not be shown.  Instead, whenever a course element or prerequisite is selected, all other course elements and prerequisite blocks that take part in its prerequisite conditions will be highlighted as follows:

In this example, the “Java Packages” block is selected, all course elements and prerequisite blocks that affect its prerequisite conditions are highlighted in a light blue color.  The prerequisite lines will not be shown in the actual application.  It is shown in the illustration for clarification. 

Show Prerequisites ( Do Not Show

This option will turn off all prerequisite lines and prerequisite highlights.

Show Completion Requirements ( Lines

This option will show all completion requirement relationships as completion requirement lines described in section 4.3.3.6.

Show Completion Requirements ( Highlights

This option will turn off completion requirement lines.  All completion requirement relations will be shown with highlights as with the prerequisite requirement highlights.  The highlight color of completion requirement is the same color as the completion requirement line.

Show Completion Requirements ( Do Not Show

This option will turn off all showing of completion requirement conditions.

Snap to Grid

This option will cause all objects to be placed along a gridline of 10 pixels apart in the X and Y direction.  It can be turned on and off.  All existing objects are not moved unless the user selects them and try to put them in a new location.

Lesson Display Options (Display Type

This option will cause the information panel in all assignable unit icons to display the type of the lesson.  This is the type property of the lesson.

Lesson Display Options (Display Time

This option will cause the information panel in all assignable unit icons to display the start and end time of the lesson.  The formats are as follows:

· Start time and end time are both non-zero or non-blank
<MM/DD/YY HH:MM of start time> to <MM/DD/YY HH:MM of end time>
The HH:MM is in 24 hours format.

· Start time is non-zero or blank and end time is zero or blank
Anytime after <MM/DD/YY HH:MM of start time>

· End time is non-zero or blank and start time is zero or blank.
Due on <MM/DD/YY HH:MM of end time>

· Both times are zero or blank.
Anytime

Lesson Display Options (Display Location

The location property of the assignable unit will be displayed in the information box.

4.5 The Toolbar


The tool bar is located to the left side of the application window.  The following behavior should be observed when implementing the tool bar:

· When the mouse moves over an icon, the icon is highlighted with a raised bevel border. 

· The following tools, when selected, is highlighted with a lowered bevel border.  It becomes the active tool. 
* Simple Prerequisite
* Completion Equivalence Relation
* Snap to Grid
These tools can be applied continuously unlike the other tools which needs to be activated by clicking on the icon every time.

· All toolbar icons shown above with a small green triangle at the bottom right hand corner has a tool bar submenu which is also shown above.

· The submenu is activated when the user clicks and holds the left mouse button on the icon with the green triangle.  Once the submenu is activated, the user can release the mouse button and the submenu will remain visible.  The submenu disappears after the user selects a new tool or clicks somewhere off of the submenu.

· The user can select a new tool icon to be displayed on the main tool bar by selecting one from the submenus.  

· Everytime a user selects a new tool, that tool becomes the active tool.

· If the mouse stays over an icon for more than 2 seconds, a tool tip text is displayed.  The tool tip text is shown to the right of each tool bar icon (or connected by a line) above.  You should use the JFC’s tooltip feature for this requiremennt.

4.5.1 Physical Specifications

Tool Bar Size

Width: 50 pixels

Height: From the bottom of the menu bar to the bottom of the application screen.

Tool Bar Icon Size: 40 x 40 pixels

4.5.2 Tool Specifications

This section specifies the behavior of each of the tool on the toolbar.  The ones not mentioned corresponds to the menu item of the same name.  They are just shortcuts.

The Simple Prerequisite Tool

The simple prerequisite tool allows the user to click on the source course element A and then the destination course element B.  This action creation a prerequisite condition “B, A”.  This in turn causes a prerequisite line to be drawn between the two.  When the user is clicking and dragging after the source course element is selected, there should be a drawn line from the right side of the course element to the location of the mouse cursor.  Please see section 4.3.3.3 under Creating Element for more information.

The Complex Prerequisite Tool

This tool is the same as the menu item Insert => Prerequisite.

The Completion Equivalence Tool

With this tool, the user creates a set of completion requirements between a source course element A and destination course element B.  These conditions are:

B, A=P, Pass

B, A=C, Complete

B, A=I, Incomplete

B, A=F, Fail

B, A=N, Not Attemped

This is basically an equivalence relationship that is most useful for equivalence or competency exams.

The method through which the source and destination course elements are connected is the same as the “Simple Prerequisite Tool”.

The Completion Requirement Tool

Clicking on this icon will perform the same action as choosing the menu item “Insert => Completion Requirement”.

4.6 Performance Requirements

The following performance metrics should be targeted.  The time given is approximate.  A + or – 10% margin is okay.  

Platform

CPU Speed: 
<= 233 MHz

Memory: 
<= 32 MB

Software: 
Any JIT compiler is fine. If used, you must document which one in the test documentation.

Course 1: 
15 AU’s, 3 Block, 15 prerequisites, 5 completion requirements with Performance Record for each course element.

· Parsing and Rendering time:  <= 2 seconds
This is the time to completely parse the course files and render the course.

· Zoom and Rendering time: <= 2 second
This is from the time the zoom resolution is selected to the time the course is finished rendering.

· Auto Wiring Rendering Time(for up to 3 lines):  <= 1 second
This is for calculating and rendering 3 new or modified lines (prerequisite or completion requirement).

· Button reaction time: <= 1 second
For any other buttons clicks or selections.   This includes selecting an AU or block and popping up a property window, clicking and dragging a prerequisite line.

Course 2: 
30 AU’s, 5 Block, 30 prerequisites, 10 completion requirements with Performance Record for each course element.

· Parsing and Rendering time:  <= 3 seconds
This is the time to completely parse the course files and render the course.

· Zoom and Rendering time: <= 3 second
This is the from the time the zoom resolution is selected to the time the course is finished rendering.

· Auto Wiring Rendering Time:  <= 1second

· Button Reaction time: <= 1 second
For any other buttons clicks or selections.   This includes selecting an AU or block, clicking the show completion requirement button, etc.

These 2 test cases can be reused for other tests described in the Testing Requirements of Part 2 of the specification. 

4.6.1 Performance Target Failure

If the performance can not be achieved, it should be because of Java limitations.  you must write a short document to describe the performance bottlenecks.  For each performance metric not accomplished, the following information should be written:

· The performance achieved (in seconds).

· Identify the main bottlenecks.

· For each bottleneck, give the percentage of time spent in the bottleneck.

· Suggest at least 1 way to overcome the performance problem.  This solution should not be an obvious one like :
* Compile into native code
* Rewrite the whole module in C++
* Get a Pentium 400+ MHz computer

There are tools available that does these performance analysises very easily.  If you use them, please specify which tool is used.

4.6.2 Memory Target Failure

For same applies for the memory target.  If it can not be achieved, it should be because of Java limitation.  In this case, write a short paragraph describing memory usage bottlenecks including the following information:

· The typical and worst case memory requirements

· In what situation does the worst case memory requirement appear. 

· What is causing the memory usage problem?


There are tools available that analyzes the memory usages very effectively.  If you use them, please specify which tool is used.

5 Work Area Element Architecture

The object architecture for representing the work area elements must be extensible.  The architecture should allow adding of new elements by simply implementing existing interfaces or extending existing classes.  No modification of existing code should be expected.   The work area elements that are extensible are only the floating icons like the AssignableUnit and Block element.   The Completion Requirement and Prerequisite Blocks do not have to have extensible architectures.

In this section, we give an overview of the architecture and the required extensible properties.  You must complete the design of the architecture. 

All extensible work area elements have the following customizable properties:

(1) They appear as icons in the main work area.  There is one icon for every zoom resolution

(2) Their properties can be imported or exported to the COURSE.XXX files

(3) They have custom property windows

(4) They serve as the endpoint of prerequisite lines.

These elements also always have a “Completion Requirement” block attached to their right side just like AssignableUnit and Blocks do.  They also are the endpoints of prerequisite lines.

When you have designed the interfaces and base classes of the architecture, you should use this architecture to implement the AssignableUnit and Block work area elements as proof.

We have included the Java interface WorkAreaElement defined in WorkAreaElement.java.  This should be the base interface for all extensible work area elements.  You are responsible for completing the implementation by putting all common attributes into this interface.

If a developer wants to add a new type of work area elements, they should only have to extend and implement new interface and not have to change any existing code.

5.1.1 Extensible Properties and Their Interfaces

In order to customize the properties that were discuss in the above section, the developer should only have to implement the following interfaces for the new element type.

Java Interface WorkAreaElement

This the basic interface for work area elements.  It contains a member function to customize the icon for the three different resolutions.  It returns 3 JComponents, one for each icon at different resolutions.

Java Interface PropertyWindow

To allow extending custom property windows, you should define a PropertyWindow interface.  All property windows should implement this interface.  You are responsible for identifying all common attributes that property windows have and making it a part of the interface.

Java Interface ObjectFactory
This interface allows the extension of new object imports.  To create a new object type, the user should implement this interface and write the custom parsing code.  Given a set of COURSE.XXX files, its implementation is responsible for generating new instances of the relevent WorkAreaElement implementation objects.  

Java Interface ObjectExporter

The developer should extend this interface to export a Java object to one or more of the COURSE.XXX files.  Its function is the exact opposite of the ObjectFactory.

The following is a diagram of how the ObjectFactory and ObjectExporter interfaces work:


These interfaces are defined in the following Java files.  You may need to modify or add to them:

· WorkAreaElement.java
· 

 HYPERLINK "Source Code\\workArea\\PropertyWindow.java" 

PropertyWindow.java

· ObjectFactory.java

· 

 HYPERLINK "Source Code\\workArea\\ObjectExporter.java" 

ObjectExporter.java

5.1.2 Example Implementation of AssignableUnit Work Area Element

The following is an illustration of using the architecture to implement the AssignableUnit Work area described in section 4.3.3.1.


In this illustration, to implement a new work area element type AssignableUnit, the following action must be done:

(1) Implement the WorkAreaElement that returns the three JComponents representing the icon at three different zoom levels

(2) Implement the PropertyWindow interface to pop up the AssignableUnit’s property window

(3) Implement the ObjectExporter interface to export AssignableUnit objects to COURSE.XXX files

(4) Implement the ObjectFactory interface to import AssignableUnit objects from the COURSE.XXX files.

6 Features & Tools Specifications
This section describes the various features and tools of the course builder and their architecture.  These include:

· Course Error Checker Tool

· Localization Features

· Undo Feature

6.1 Course Error Checker Tool

The course error checker is launched whenever:  

· The user tries to save the course

· The user launches it from the menu Tools => Error Checker.

The course error checker is like a compilation tool.  It will check for errors and warnings  in the course elements and the course structure.  All errors must be fixed before the course can be saved.  The following is a list of errors that the error checker looks for:

(1) Prerequisite block with no outgoing prerequisite lines

(2) Prerequisite conditions with invalid course element system ID’s.
This case occurs when a course element was deleted. 

(3) All completion requirement conditions with invalid course element system ID’s.

(4) There is a loop in the prerequisite structure

(5) An AU’s start time property is >= the AU’s end time property

(6) An AU’s start time – end time property is > 8 hours (Warning).

In case (1), the prerequisite block should be flashing blue as a warning to the user.  In case (2) and (3), the line will flash their line color to indicate an error condition.  The following the window assocaited with the error checker.

Main Error Categories

The main error categories are:  

· Checking Lessons

· Checking Prerequisites

· Checking Completion Requirements

If there are any error conditions in the category, the category is marked with a X icon on the left.  The whole line is also displayed in red.  All of the error conditions under this category is displayed.

If there is no error condition in the category, the category is marked with a check mark on the left.  The whole line is displayed in green.

Error Condition

The above picture illustrates all of the errors and warnings currently possible in the system.  All such conditions are displayed under the category they belong to.  Errors are displayed in red text and warnings are displayed in dark yellow text.  There is a X mark next to all error conditions and a dot next to all warning conditions.

When the check is complete, the first error or warning condition is highlighted & selected.

Warnings do not count as errors.

Recheck Button

The recheck button reruns all of the checks again.  

Continue Button

The continue button hides the window and passes the final status of the check to whoever is interested.  The statuses can only be: Pass or Fail.  When saving courses, the course error checker is invoked first.  When the user clicks on the “Continue” button, this status is checked.  If the status is Pass then the course is saved.   Otherwise, an error dialogue will appear telling the user not all errors have been fixed.  Warnings do not count as an error.

Go To Problem Button

This button will center the object that is causing the error in the visible work area.  The object will be selected and its property window will appear.

6.2 Undo/Redo Feature

The menu item “Edit => Undo” allow users to undo changes that they have made.  The “Edit => Redo” allows users to undo the “Undo” action.  This implies that an undoable action can also be redone.  All undoable action is listed below.  Each action has a “Begin Action” and an “End Action” condition.  To undo an action, all edits between the “Begin Action” and “End Action” conditions are undone.  To redo an action, all edits between two conditions are redone.  All edits refers to the difference in state between right before “Begin Action” and right after “End Action”.

Insert => Completion Requirement or Insert => Prerequisite Requirement

Begin Action:  Immediate after the menu option is chosen.

End Action: When the user clicks on the “Okay” button in the “property panel” property window.

Inserts a Completion Equivalence Relation or Simple Prerequisite  from the Toolbar

Begin Action: Immediately before the user clicks on the source course element icon.

End Action: Immediately after the user clicks on the destination course element icon.

Insert a Complex Completion Requirement or Prerequisite from the toolbar

Begin Action: Immedidately before the user clicks on Complex Completion Requirement Icon on the toolbar.

End Action: Immediately after the user clicks on the “Okay” button of  the property window. 

Cut/Delete a Course Element, Prerequisite line, Completion line, or Prerequisite Block

Begin Action: Immediately before the “Cut” or “Delete” option is chosen.

End Action: Immediately after the object and associated objects are deleted.

Paste a Course Element, Completion Requirement Block, or Prerequisite Block

Begin Action: Immediately before the item or items are pasted

End Action: Immediately after the item or items are pasted

Delete All

Begin Action: Immediately before the option is chosen

End Action: Immeidately after the option is chosen and everything is deleted.

Changing values in a property Window

Begin Action: Immediately before the field was changed.

End Action: Immediately after the field is changed.

NOTE: All such undoable actions in the property window are undoable as long as the property window is open.  Once the property window is closed, all the text field edit undoable actions are removed and can no longer be undone.  This means, these actions are removed from the stack which is described below.

Modifying Prerequisite or Completion Requirement Line placement

Begin Action: Immediately before the user left click and holds on a line segment

End Action: Immediate after the user releases the mouse button.

All undoable actions are stored on an undo stack.  The property of the stack is as follows:

(1) Initially, the undo stack is empty.  The stack pointer is pointing to the top of the stack (which is empty).

(2) Everytime an undoable action is complete, this action is pushed onto the stack.

(3) If the stack pointer is pointing to the top of the stack or the stack is empty, the “Redo” option is disabled.  This means the “Redo” menu option is painted in light gray letters and can not be selected.

(4) If the stack pointer is pointing to the bottom of the stack or the stack is not empty, the “Undo” menu option is disabled.  This means the “Undo” option is painted in light gray letters and can not be selected or activated through Ctrl + Z.

(5) When “Redo” is selected, the stack pointer is moved one action up the stack (toward the stack top).  Then the action pointed to by the stack pointer is reapplied.

(6) When “Undo” is selected, the stack pointer is moved one action down the stack (toward the stack bottom).  Then the action pointed to by the stack pointer is undone.

The depth of the undo stack should be settable.  Initially, it should be 20 deep.  You must use the TEMP directory listed in section 3.1 for any intermediate data that you would like to save to disk.

You should use the JFC’s undo architecture to implement this feature.  It is located in the com.sun.java.undo package.   An illustration of the undo stack in action is available on Slide 20 in the Course Builder Specification PowerPoint slide.

7  Requirements
7.1 Coding Requirements

In this section, we cover the Java coding requirements that Training Software LLC has for the developer.

7.1.1 Java Development Environment

You are required to develop using the following platform.  The recommended parts are marked by the [recommended] flag.

Platform:  
300 MHz PII or above [recommended]

Memory:    
64 MB

IDE:
Borland JBuilder 2.0 Client/Server Suite

JDK Ver.:
1.1X. 

However, do not use any functions or features that will be deprecated in 1.2.

Libraries:
Try not to use AWT.  
Use JFC whenever possible.  


No Microsoft AFC


You may use beans, classes, and libraries that is not a part of JDK and JFC if: 

· The components needed can be extracted and packaged into a product.

· If the additional libraries size exceed 50K, you must get my approval.

· The library is free to be distributed.

· Everything used is cross platform (runs on all platforms Java JDK & JFC runs on)

JIT:
You may use any JIT compilers as long as:

· It can be extracted and put in the final package.

7.1.2 Coding Styles

This section contains coding style specifications that should be followed.

1.  Functions should be less than 40 lines each

Each member function should be less than 40 lines of code each (not including comments).  If a function needs much more than 40 lines, you should divide it into 2 or more functions and make a function call.

2.  Class files should be less than 200 lines each

Each class should have less than 200 lines of code each (not including comments). If the class requires more than 200 lines, it usually means that you are trying to put too much functionality into one class.  This reduces modularity and expandability.  If you need more than 200 lines, try to break the functionality of the class into two or more classes. 

3.  All Java classes should follow the Java Beans naming convention

The Java Bean style of coding must be followed!  This is very important.  The Java Beans coding convention specifies that there are three different types of member functions:

(1) Properties

(2) Methods

(3) Events

Properties

Properties member functions start with either a “set” or “get” word.  These functions are used to access and modify class properties (or member data).  You should never access member data directly.  The following is an example:




For boolean properties (properties that are of the boolean type), instead using “get”, use “is”.  For example:


Methods

Methods are normal member functions that performs a certain task like sort, find, and draw.  These member functions start with a lowercase letter.  For example, sort() and find() are both methods.

Events

Event methods are member functions that uses the delegation event model for event handling in Java 1.1.  This means, each class has a list of other classes that are listening to events.  When an event is generated, everyone on the list is notified.  To add and remove someone onto the event listening list, the following function should be used:



public void add<Event Type>Listener(<Event Type>Listener l);


public void remove<Event Type>Listener(<Event Type>Listener l);

The <Event Type>Listener class is an interface class.  The definition must be as follows:


public interface <Event Type>Listener extends EventListener {


  ...list of functions that notify the listener something has happened...

}

The following is an example of a clock class using the Java Beans Event method coding standard:


The following is the AlarmEventListener Interface that goes with the class:


The following is the AlarmEvent class that must also be implemented:


These are the only three types of functions that are allowed inside any Java class.  The object to object communications is done through the Java 1.1 Event model as described above.  For more information, refer to any Java Beans or Java 1.1 book.

4.  Variable naming convention

All variables must be named starting with a lowercase letter.  Each different word’s first letter is capitalized.  Do not use _, - or any other kind of word connectors.  For example, studentTable, studentRoster, instructorName are all valid variable names; however, InstructorName, instructor_name, and instructorname are not.

5. Class naming convention

All class name must be have its first letter capitalized.  Each different word’s first letter is also capitalized.  Do not use _, - or any other kind of word connectors.  For example, ActionEventListener, AlarmEvent, and Action are all valid class names; however, actionEventListener, ACTIONEVENT, Actionevent, and Action_Event are not.

6. Input Parameter Error Handling

For every member function, you should take care of unexpected inputs.  For example:

· A null is passed in as a parameter when null is not expected.  

· A negative integer is passed in as a parameter when a positive integer is expected.

All errors on input generate an IllegalArgumentException.  With the exception you must pass a detailed error message of the following form:

“Argument <argument name>:  <reason for the error>”

<argument name>:  This is the argument variable name that the error occurred on.
<reason for the error>: A sentence describing what the function expects and what was actually passed.

7. Return Values and Exceptions

For every member function that get or create an object by id or a set of ids, the following return values and exception rules should be observed:

· get: If the object is not found, a null should be returned

· get: If there are multiple matches when there should only be one, a RuntimeException should be generated.  The following string should be passed as the constructor input with the RuntimeException:
“Duplicate Record Found: <record id>”
The <record id> should be some identifier of the record that is duplicated.

· create: If there is already an existing record and no overwrite behavior is specified, a RuntimeException should be generated with the following string as the constructor input:
“Attempt to overwrite/create record: <record id> when overwrite not allowed” 
The <record id> should be some identifier of the record that is being created or overwritten.

7.1.3 Commenting

1.  Each Method type member function of a class must be documented.  
The document should include: All input parameters, the returned value, and the function description.

Each input parameter should have the parameter name and then a brief 1 sentence description of what it is for.  The return parameter should have the return type and also a brief 1 sentence description.  Also, all exceptions generated by the function must be documented as well.

The following is an example.  This javadoc commenting guidelines should be followed.

/**

 * This function sorts the input array in order specified by the
 * input parameter “order”.

 * @param input An array of integers
 * @param order Determines which order to sort in.  The possibilities are: 

 *

   MyClass.ASCENDING, MyClass.DESCENDING
 * @return The sorted array of integers

 * @exception DuplicateIntegerException When an integer value appears more

 *

 more than once in the input array.

 */
public int function(int[] input, int order) throws DuplicateIntegerException {}

2. Each Event type member functions should be documented.

Each addXXXListener function should be documented.  The documentation should list what events its generates and a brief description of when that event occurs. 

The following is an example:  This format should be followed:

// Events: 
//   SizeChangedEvent – when the window size changes

//   ColorChangeEvent – when the color of the icon changes.

public void addChangeListener(ChangeListener l);

public void removeChangeListener(ChangeListener l);

3.  Document get/set member functions if they affect something non-obvious.

For get/set member functions that simply get from and assign to a member variable, you do not have to document them.  If the get/set member function sets does something that is not directly obvious then the documentation should include what kind of action it triggers.

4.  All class files must include a class file description comment.  

The class file descripion comment must include:

· A 1 paragraph description of the class and what it does.

· A list of related classes.

· The author

· The creation date

If you are using JBuilder, you should use the “Generate Header Comment” option when you create a new class.  The following is an example.  This format should be followed:


The “Related Classes” section should use the @see tag specified by javadoc.

5.  All branch conditions must be documented.

Each branch condition should be documented.  This includes what it takes to reach each branch of the condition and what the branch block does.  The following is an example and the format should be followed:

if (previous = next) {   // If two consecutive cells are equal.

   throw DuplicateIntegerCondition; // error condition.

} else {

     // If two consecutive cells are not equal.

   int swap = previous;  // Swap the 2 cells.

   previous = next;

   next = swap;

}
7.2 Project Management Requirements

We have several requirements in regards to managing the project:

7.2.1 Communication Channels

John Yin will be contacting your group regularly over the course of the project to find out the status and to discuss changes.  You must provide one the following channels in addition to e-mail, fax, and telephone through which I can interact with the project lead and possibly the group members:

(1) Yahoo Pager’s talk function
You should register an account with My Yahoo.   We will be able to communicate interactively through this service. 

(2) An IRC server
You should setup an irc server to which I can connect and discuss in private.

7.2.2 Meetings and Scheduled Events

Project Timetable

You project lead/project manager must submit a project timetable within one week of signing the contract.  This timetable should have a detailed schedule of the todo items in the project and what time they should be completed by.

Two Status Meetings Per Week
We must hold two status meetings per weekly meetings.  In these meeting, I will try to get an idea of the progress made so far and to solve any outstanding problems.  The project lead must be present during these meetings.  If he or she can not make it, someone who is familiar with the project status must be present.  Before the meeting, I will call or e-mail to set up a time and method.  The possible methods are:

(1) Regular Telephone

(2) Yahoo Pager’s Talk feature

(3) IRC

Monthly Milestone Checkup

I will also contact you using the same methods once a month to discuss milestone status.  All members of the team should be present.  This meeting should be held no later than 30 day intervals from the date when the contract is signed.  In some cases, I may travel to your location and to meet instead of over long distance.

Weekly Source Code Transfer

No later than two days after each weekly meeting, all of the source code you have so far must be zipped e-mailed to me. 

7.2.3 Project Milestones

We define the project to have a set of milestones.  The order in which the milestone appears is the order we require you to complete them.  They are:

Milestone 1: Project Setup

This milestone is considered reached if the following items are complete:

(1) A detailed project management timetable including:

· A breakdown of the project into major job modules

· Attach people to job modules and the person in charge of the module.

· Breakdown of job modules into approximately one-man week job segments.

· Attach time schedules to each module and job segment with starting time and deadline.

You must submit a work breakdown chart similar to the following:


There must always be 3 categories: Design, Implementation, Testing.  Under each category, the minimum item time is 5 man-days.  The largest item in the list can be 4 man-weeks.   

In addition, you must schedule these items in a timeline.  You must submit the timeline along with the above table.  The timeline must contain each item and what week they are scheduled to be completed in.

(2) Setup the development environment

The development environment that is explain in section 7.1.1 should be set up for all members of the team.

(3) All communication channels setup.

Mileston 2: Basic Layout Framework

In this milestone, the following items must be finished:

GUI elements

· File menu – All menu items must be present.  

· Work Area – The scrollable work area is usable as defined by the Features Finish below.

Features Finished

· Save feature finished

· Able to insert at least 1 type of lesson through the Insert menu
 

· Ability to edit the property window of a inserted lesson

· Ability to insert simple & complex prerequisites 
The wiring does not have to be intelligent.

· Ability to insert blocks and edit the block properties.

Milestone 3: Advanced Layout Framework

In this milestone, the following items must be finished:

GUI elements

· Course Display Bean

· The toolbar

Features Finished

· Able to wire prerequisites through the toolbar Insert Prerequisite Line tool.
An semi-intelligent wiring logic must exist at this point.

· Able to wire completion requirements and insert it.
The wiring should also be semi-intelligent

· The Course Display Bean can display what we have so far.

Milestone 4: Coding Finished

All coding must be finished at this point.  This include source code documentation .

Milestone 5: Testing and Packaging Finished

All debugging for the project must be completed and the packaging done.

7.3 Packaging Requirements

The final packaged project should be zipped into one file and e-mailed to me.  If the file is too large to transfer, then we will work out a way to pick up the project. 

The directory structure of this zip file should be:

Client\

Source\

The Client directory should contain the directory structures specified in section 3.1.  It should contain ready to run course builder and the course builder display application.   We should be able to start it by setting the appropriate environment variables and executing the “Command Line” texts in section 3.1.

The Source directory should contain all of the Java source code and project files.

Appendix A. Course Export/Import Files

A.1. The Course Filetc "6.1  The Course File" \l 2



Description

xe "course file"
This file contains information about the course as a whole.  It offers information that relates to more than just a single element in the course.


File type
Group/Keyword  (MS Windows INI)



File name
xxxxxxxx.CRS

The extension for this file is CRS.  Any legal eight characters may be used for the primary file name.



Groups and keywords
This file contains three groups.


Group Names and Keywords
Function of Keywords


[Course]

Course_Creator

Course_ID

Course_System

Course_Title

Home_Page

Max_Fields_CST

Total_AUs

Total_Blocks

Level

Location

Start_Time

End_Time

Max_Score

Max_Enrollment

Instructor
This group contains information that applies to the course as a whole.  Some of this data is designed to help in processing the other files that provide more detailed information on the elements in the course and how they are ordered.


[Course_Description]




Textual description of the course.

A.1.1
[Course] Keywords

tc "6.1.2  [Course] Keywords" \l 3




Keywords
This list of keywords is in a logical order for their appearance in the file.



Course Class Property

Keyword
Description

creator

Course_Creator 
Name of group that authored the course.

ID

Course_ID
Identifier for the course

systemVendor

Course_System
Name of the authoring system used to create the course.

title

Course_Title
Common name given to the course.

homePage

Home_Page
The home page of the course if any

level

Level
The complexity level of the file and the course description contained in the file.

N/A

Max_Fields_CST
Maximum number of fields appearing in the Course Structure Table file.

N/A

Total_Aus
Total number of AUs in the course.

N/A

Total_Blocks
Total number of blocks in the course.

location

Location
The location of the course if any.

startTime

Start_Time
Time the course starts

endTime

End_Time
Time the course ends

maxScore

Max_Score
The maximum score possible on the score

maxEnrollment

Max_Enrollment
The maximum number that can enroll in the course.

instructor

Instructor
The instructor in charge of the course.

A.1.1 [Course] Keyword

Course_Creator=

xe "course_creator keyword"
Definition
Name of the vendor and/or author of the course.




Data format
Alphanumeric.  All characters, beginning with the first printable character after the equals sign are significant.




Examples
Course_Creator = Boeing Commercial Airplane Group, \

Customer Services

Course_Creator = Airbus



Course_ID=

xe "course_id keyword"
Definition
Alpha numeric sequence that uniquely identifies a course.  


Argument format
Alphanumeric characters.  All characters, beginning with the first printable character after the equals sign are significant.




Examples
Course_ID = A320-FT-002

Course_ID = 767-224-4.MT

Course_System=

xe "course_system keyword"
Definition
Name of the predominant authoring system used to create the course.  The authoring system used to create the greatest number of units in the course.




Data format
Alphanumeric.  All characters, beginning with the first printable character after the equals sign are significant.




Examples
Course_System=Authorware

Course_system = PCD3

course_system = AIS II



Course_Title=

xe "course_title keyword"
Definition
Common name given to the course.  Probably used by the CMI system when identifying course for student.




Data format
Alphanumeric.  All characters, beginning with the first printable character after the equals sign are significant.




Examples
Course_Title = 747 Flight Crew Training

Course_Title = Maintaining 747 Avionics



Home_Page=

xe "max_fields_cst keyword"

Definition
The home page of the course.


Format
URL String




Examples
Home_Page=http://www.trainingsoft.com/course/A12





A.1.1 [Course] Keyword (cont.)

Level=

xe "level keyword"
Definition
Hard coded to 3. 



Max_Fields_CST=

xe "max_fields_cst keyword"

Definition
Identifies the maximum number of fields that are in the course structure table (any.CST file).


Format
Numeric characters.




Examples
Max_fields_CST=12

; There is at least one block (or the course itself) that

;  has 11 members.

Max_Fields_CST = 9



Total_AUs=

xe "total_aus keyword"
Definition
The total number of unique assignable units in the course.  This information aids in the processing of information in the file.





This number does not necessarily represent the largest digit used to identify an AU.  If there are 5 lessons in a course, they do not have to be identified as A

.001, A.0021, A2, A3, A

.003, A.004, and A.004, and A5.  AU identifiers do not have to be consecutive.  A course with 5 lessons (Total_AUs=5) could have the identifiers A

.00008, A.00064, A.00512, 8, A64, A512, A4096, A2768




Format
Numeric characters.




Examples
Total_AUs = 3

; There are three assignable units in the course.

Total_AUs= 84

total_aus = 138



Total_Blocks=

xe "total_blocks keyword"
Definition
The total number of unique blocks in the course.  This information aids in the processing of the rest of the data in the file.





This number does not have to be equal to the largest number used in an extension.  Identifier extensions do not have to be consecutive.




Format
Numeric characters.



A.1.1 [Course] Keyword

Location=

xe "course_id keyword"
Definition
Alpha numeric string that identifies the main location where this course is held.  This value is generated from the location property in all of the AU’s belonging to this course.  

AU’s that have no empty location properties do not count.  If the remaining AU’s have multiple locations, this field should have the value “Multi-location”

This value is generated by the CMI Management Client when the export files are passed in from the Course Builder.




Argument format
Alphanumeric characters.  All characters, beginning with the first printable character after the equals sign are significant.




Examples
Location=Builder 14, Room 4a, Santa Teresa Site

Location=Multi-location



Start_Time=

xe "total_blocks keyword"
Definition
The time the scheduled portion of the course officially start.  It is the earliest start time of all of the AU’s in the course.  If no start time is available then it defaults to 0




Format
Time Text: MM/DD/YYYY HH:MM [AM/PM], GMT

MM = Month

DD = day

YYYY = year

HH = hour

MM = minute


Examples
Start_Time = 12/08/1971 08:00 AM, GMT



End_Time=

xe "total_blocks keyword"
Definition
The time the scheduled portion of the course ends.  It is the latest start time of all of the AU’s plus the duration of that AU.  If no end time is available then it defaults to 0 which stands for no end time.




Format
Time Text: MM/DD/YYYY HH:MM [AM/PM], GMT

MM = Month

DD = day

YYYY = year

HH = hour

MM = minute


Examples
End_Time = 12/09/1971 08:00 PM, GMT



Max_Score=

xe "total_blocks keyword"
Definition
The maximum score a student can get on the course.  




Format
Numeric characters


Examples
Max_Score = 100



Max_Enrollment=
Definition
The maximum number of students that can enroll in the course.  Anyone who tries to enroll when the course is full is denied enrollment.




Format
Numeric characters


Examples
Max_Enrollment = 50



Instructor=

xe "total_blocks keyword"
Definition
The instructor in charge of the course.




Format
User ID (Alpha numeric string of up to 11 chars).


Examples
Instructor = joeyoung5



A.1.2
[Course_Description]

tc "6.1.4  [Course_Description]" \l 3




Definition
This is a textual description of the contents of the course.  It may contain the purpose, or the scope, or a summary of the course objectives.  The content of this field is determined by the desires of the author.



Corresponding Course Class Property
description

Format
Freeform text.  Each line is limited to 254 characters.  On long lines carriage returns can be indicated with the characters "<cr>" embedded in the string.  Also, carriage returns are implied (explicitly) at the end of each line.

A.2. Assignable Unit Filetc "6.2  Assignable Unit  File" \l 2

xe "assignable unit file"




Description
Information relating to the assignable units (AU) in the course.  Each AU has its own record (or row in the table).



File type
Table  (Comma-delimited ASCII)



File name
xxxxxxxx.AU

The extension for this file is AU.  Any legal eight characters may be used for the primary file name.



Fields


The first record contains the field identifiers.  The order in which these field identifiers appear determines the order of the data in subsequent records.  Each following record in this file describes a different assignable unit.  Each record has the following fields.




Assignable Unit File: the fields
Field Name
System ID
Type
Home_Page

Continued (
Location
Start_Time
End_Time

Continued (
Lesson
Mastery_Score
Max_Time_Allowed

Continued (
Time_Limit_Action
Comments

Example file contents
The three records below are extracted from the beginning of a hypothetical file.  



"system_id","type”,”homePage”,”location”,”startTime”,”endTime”,”lesson”,”masteryScore”,”maxTimeAllowed”,”timeLimitAction”,”comment”

"A11", “WebLesson”,,,,,”L1”,”95”,”99:99:99”,”Continue”,”Take this lesson<cr>at your own risk”

"A12", “CMICompliantLesson”,,,,,”L23”,”80”,”02:15:00”,”Exit, Message”,

"A13", “InstructorLedLesson”,”http://a.b.c/56.html”,”Building 14, Room 4A”,”7/12/1998 05:00 AM, GMT”,”7/12/1998 06:00 AM, GMT”,”L56”,”100”,”01:00:00”,”Exit, Message”,



A.2  Assignable Unit Fields

System ID

xe "system id field"
Description
The system ID of the assignable unit.  Same as the systemID property of the AssignableUnit Java Class.



Type

xe "type field"
Definition
The type of the lesson that belongs to the AU.




Data format
Alphanumeric.  Not case sensitive.  May contain spaces and commas.  The valid types are:
WebLesson

CMICompliantLesson

InstructorLedLesson




Examples
"WebLesson"

"CMICompliantLesson"

“InstructorLedLesson



Home_Page

xe "command line field"
Definition
The home page for the AU.  Optional




Data format
URL String




Examples
"http://www.trainingsoft.com/course/c5/a12.html"



Location

xe "command line field"
Definition
The physical location where the training  will take place.


Data format
Alphanumeric




Examples
"Building 14, Room 4A"

“T.S. Training Center, 456 Training Blvd., San Jose, CA”



Start_Time

xe "total_blocks keyword"
Definition
The time the AU starts.  If blank then there is no start time which means it is most likely a CBT lesson.




Format
Time Text: MM/DD/YYYY HH:MM [AM/PM], GMT

MM = Month

DD = day

YYYY = year

HH = hour

MM = minute


Examples
Start_Time = 12/08/1971 08:00 AM, GMT



A.2 Assignable Unit Fields (cont.)

End_Time

xe "total_blocks keyword"
Definition
The time the AU ends.  If blank then there is no end time which means it is most likely a CBT lesson.




Format
Time Text: MM/DD/YYYY HH:MM [AM/PM], GMT

MM = Month

DD = day

YYYY = year

HH = hour

MM = minute


Examples
End_Time = 12/09/1971 08:00 PM, GMT



Lesson
Definition
The lesson that belongs to this AU.  Recall that lesson objects represents the training material and its behavior on execution.




Format
Lesson ID.

It is the ID field (internal ID) of the corresponding lesson object.




Examples
“TS-5-198”

“L56”



A.2  Assignable Unit Fields (cont.)

Mastery_Score=

xe "mastery_score keyword"
Definition
When the raw score is greater than or equal to the mastery score, the student is considered to have passed, or mastered the content.  




Argument format
Integer number.




Examples
mastery_score = 75

Mastery_Score = 100

MASTERY_SCORE=5



Max_Time_

Allowed=

xe "max_time_allowed keyword"
Definition
The amount of time the student is allowed to have in the current attempt on the lesson.  See time_limit_action (next) for the lesson's expected response to exceeding the limit.




Data format
TIME: Hours, minutes, and seconds separated by a colon.

hh:mm:ss




Examples
“0:14:30”

“ 2:03:00”



Time_Limit_

Action=

xe "time_limit_action keyword"
Definition
Tells the lesson (or test) what to do when the max_time_allowed is exceeded.  There are two arguments for this keyword.

\SYMBOL 183 \f "Symbol" \s 12 \h
What the lesson should do -- Exit or Continue

\SYMBOL 183 \f "Symbol" \s 12 \h
What the student should see -- Message or No message




Format
Two letters, words, or phrases separated by a comma.  The possible arguments are

Exit (or E or e)
Continue (or C or c)
Message (or M or m)
No_Message (or N or n)

Only the first letter of each word or phrase is significant.  Capitalization is ignored.




Examples
“ Exit, Message”

;     The lesson presents a message to the student

;     indicating he has exceeded the time 

;     limit in the lesson, and then exit or quit.

“E,N”

;     The lesson quits or exits with no message to the

;     student.  He jumps to the CMI environment.



Comments

xe "time_limit_action keyword"
Definition
Comments for this Assignable Unit.  Used for sending bulletin messages about a particular AU to students who are taking the course.




Format
TEXT, carriage returns are encoded by <cr>




Examples
“This has been canceled<cr>Moved to Wed @ 3:00 p.m.”



A.3. Descriptor Filetc "6.3  Descriptor  File" \l 2

xe "descriptor file"

xe "course descriptor file"




Description
This file contains a complete list of every course element in the course.  It is used as the basic cross reference file showing the correspondence of system generated IDs with user defined IDs for every element.  This file also contains any textual description created for an element in the course.  Course elements include

\SYMBOL 167 \f "Wingdings" \s 12 \h
Assignable Units

\SYMBOL 167 \f "Wingdings" \s 12 \h
Blocks



File type
Table  (Comma-delimited ASCII)



File name
xxxxxxxx.DES

The extension for this file is DES.  Any legal eight characters may be used for the primary file name.



Fields 
Each record in this file describes a different element in the course.  Each record has the following fields. Their order is determined by the order in which the field titles appear in the first record.



Required fields
Although all field titles must be in the file for level 1 compliance, only the following field values are required:

System_ID

Developer_ID

Title



Descriptor File: the fields
System ID

(for course element)
Developer ID

(for course element)
Title
Line number
Description

System_ID
Developer_ID
Title
Line_Number
Description







A.3 Descriptor Fields

Example file contents
The records below are extracted from the beginning of a hypothetical file.  

"system_id","developer_id","title","line_number","description"

"A1","PP1-2","Power Plant Introduction",1,"An overview of the operation of the primary"

"A1","PP1-2","Power Plant Introduction",2,"systems in the Pratt & Whitney PW2037 engine."

"A2","PP2-1","Power Plant Fuel System",1,"Fuel movement from the tank to the combustors."

"A3","PP3-1","Power Plant Oil System",1,"Oil circulation system in the PW2037 engine."

* The developer_id corresponds to the vendorID property of the BaseLesson class(see BaseLesson.java)

A.3  Descriptor Fields (cont.)

System_ID

xe "system_id field"
Definition
System assigned ID.  The exporting system for the course structure, generates a simple ID for every course element.  That ID must appear in this file.

This simple ID has two parts.  A letter and a number.  

The letter identifies to what category element the record refers.  Possible categories (types) are:

\SYMBOL 167 \f "Wingdings" \s 12 \h
A -- Assignable Unit

\SYMBOL 167 \f "Wingdings" \s 12 \h
B -- Block

The number is a simple integer to distinguish each unique item in a category.




Data format
Alphanumeric.  Not case sensitive.  The first letter is an A, B or J.  That is followed by an integer number.




Examples
"A15"

"B1"



Developer_ID

xe "developer_id field"
Definition
Developer assigned ID.  Unique identifier for an assignable unit or block.  Used outside of this structure file to refer to a specific element. 




Data format
Alpha-numeric string.  No internal spaces.




Examples
"APU-747-003"

"747-423-ELEC-001"



A.3  Descriptor Fields (cont.)
Title

xe "title field"
Definition
Commonly used name for an assignable unit, block, objective, or complex objective.  Probably used by CMI system in menu screens where students can select an assignable unit or block, or select to see the status of an objective.




Data format
Alphanumeric.  Not case sensitive.  May contain spaces and commas.




Examples
"Auxiliary Power Unit, Part 1"

"Auxiliary Power Unit Start"

"Electrical Power, Part 3"



Line number

xe "line number field"
Definition
Identifies the line number of the description field that follows.  In some cases, a description might be too long to fit into a two-hundred-fifty-four character field.  When the description is too long, it requires multiple records.  All fields are the same for these records, except the line number and description.




Data format
Integer number.




Examples
1

12

2



Description

xe "description field"
Definition
This is a textual description of the assignable unit and block.  It may contain the purpose, or the scope, or a summary of the element.  The content of this field is determined by the desires of the author.




Data format
Text.  Limited to 254 characters.  For longer descriptions, multiple records are required.  It is possible to embed carriage returns in a single line by using the "<CR>" combination. (Not case sensitive -- <cr> works as well.)



A.4. Course Structure File

tc "6.4  Course Structure File" \l 2

xe "course structure table"



Description
This file contains the basic data on the structure of the course.  It includes all of the assignable units and blocks in the course.  The order in which these appear in the file implies (but does not force) an order for presentation to the student.  

Even though the student may have the option of selecting any assignable unit or block, the CMI router will probably list them in the order in which they appear in this file.

If a specific order is required by the developer, that order is specified in the prerequisites table.



File type
Table  (Comma-delimited ASCII)



File name
xxxxxxxx.CST

The extension for this file is CST.  Any legal eight characters may be used for the primary file name.



Records
Each record in this file describes the members of a course or block, and implies a level in the course hierarchy. The order of the records must be respected both upon import and export to achieve minimum AICC compliance.


Fields 
Each record has a variable number of fields, limited by the Max_Fields_CST keyword in the Course file.  Each different assignable unit or block that appears in the file must have a unique identifier.

The first field in each record is always the course or block identifier.  The course is always identified by the word “root”, and the block identifier is always arbitrarily determined by the course generation routine.  The block identifier is found in the “system_id” column of the Descriptor File.

Each block identifier will always appear more than once in a file -- the first appearance identifies where the block is in the hierarchy; the second appearance identifies the members of the block.  Assignable units may appear more than once.


Usage rules
The first entry in the file is always "root."

Each subsequent entry is a system generated ID (system ID).  The ID indicates the type of element and that it is a member of the course (root) or block that is identified in the first field.

A block will always appear in the file first as a member of another group (another block or the root).  The second appearance of the block usually defines the membership of the block.  (In some cases a block may appear in more than a single block in the course, in which case the membership may be described in the third or fourth appearance of the block ID.)



Course Structure Table, v1.1

Block
Members -- Assignable units & other blocks

Root
Member
Member
Member
Member







A.4.1
Example 1

tc "6.4.1  Example 1" \l 3




Description
This is a simple course that is described in three ways.  The first description is a diagram, the second is a table, and the third is the contents of a Course Structure File.
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Example table
The table below reflects the diagram above.  Each course element in this table uses the "Developer ID" -- the unique identifier assigned by the ISD organization during development of the course.




Table for Introduction Course


Root
AU 1
Block 1
Block 2


Block 1
AU 2
AU 3



Block 2
AU 4
AU 5
AU 6

Example file contents
The records below reflect the table and diagram above.  Each ID is a "System ID" -- ID assigned by the system that generated the files for the export of this course.



"block","member","member","member"

 "root","A1","B1","B2"

"B1","A2","A3",""

"B2","A4","A5","A6"

A.4.2
Example 2

tc "6.4.2  Example 2" \l 3




Description
This is a simple course that was described in the introduction to this chapter.  It is described here in three ways.  The first description is a diagram, the second is a table, and the third is the contents of two key files: the Descriptor File and the Course Structure File.
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Example table
The table below reflects the diagram above.  Because each entry in the file must be a unique identifier, the table also includes the exporting-system generated ID (System ID).




Table for Example Course


Root
Electrical

B1
Power Plant

B2
Fuel

B3



Electrical

B1
AC

A1
DC 

A2
Procedures

A3



Power Plant

B2
Fuel

A4
Oil

A5
Pneumatics

A6
Procedures

A7


Fuel

B3
System

A8
Procedures

A9



Example file contents
The records below represent the contents of the Descriptor File, and reflect the table and diagram above.



Filename:  example.DES

"system_id","developer_id","title","line_number","description"

"A1",,"AC Electrical",,

"A2",,"DC Electrical",,

"A3",,"Electrical Procedures",,

"A4",,"Power Plant Fuel",,

"A5",,"Power Plant Oil",,

"A6",,"Power Plant Pneumatics",,

"A7",,"Power Plant Procedures",,

"A8",,"Fuel System",,

"A9",,"Fuel Procedures",,

“B1”,,”Electrical Power”,,

“B2”,,”Power Plant”,,

“B3”,,”Fuel”,,

Example file contents
The records below represent the Course Structure File, and reflect the table and diagram above.



Filename:  example.CST

"block","member","member","member","member"

"root","B1","B2","B3",

"B1","A1","A2","A3",

"B2","A4","A5","A6","A7"

"B3","A8","A9",,

A.5. Prerequisites Filetc "6.6  Prerequisites File" \l 2




Description
Sometimes it may be desirable to prevent a student from entering a lesson until he has met certain prerequisites.  This file allows that sort of constraint to be placed on each block or assignable unit (AU) in a course.



File type
Table  (Comma-delimited ASCII)



File name
xxxxxxxx.PRE

The extension for this file is PRE.  Any legal eight characters may be used for the primary file name.



Records
Each record allows a single prerequisite (Level 2) or list of prerequisites (Levels 3 - 4) to be defined for a block or AU.  



Fields 
The first record identifies the order of the fields with the field names: Structure_Element, Prerequisite, and Mode.

The system generated ID is in the structure_element field.  The prerequisite field is an expression (See the section on Logic Statements) that identifies the course elements that determine whether a student can begin the block or AU.  






Prerequisites File

Level 3
Structure Element

(Block or AU)
Prerequisite Logic Statement

(Blk, AU or Obj)

(Correpsonds to the
Structure_Element
Prerequisite

 hard coded level 3 in
System ID
System ID & System ID

 the Course fields)
System ID
System ID | System ID


System ID
System ID


System ID
System ID & (System ID | System ID)

Usage rules
When there is no prerequisite defined for an AU or block, the student may select that course element at any time.

When there is no prerequisite for an AU that is part of a block, and the block does have prerequisites, then that AU may be taken anytime the block prerequisites are met.

When an AU or block does not appear in the file, it is assumed to be an AU or block with no prerequisites. (i.e. The above rules apply.)



Example file contents
The records below are extracted from the beginning of a hypothetical file.



structure_element, prerequisite

"B13","B12 & A14"

"A48","B12 | B11"

"A49","A48","R"

"A50","B12 & (A15 | A16)"

A.5.1
Assignable Unit and Objective Status

tc "6.6.1  Assignable Unit and Objective Status" \l 3




Assignable Unit (lesson) status
Prerequisites are a listing of those course elements that a student has completed.  Completed is a status.  Lesson status is often determined within the lesson by the logic designed into it.  




There are five possible statuses for each lesson.  

\SYMBOL 183 \f "Symbol" \s 12 \h
Passed

\SYMBOL 183 \f "Symbol" \s 12 \h
Completed

\SYMBOL 183 \f "Symbol" \s 12 \h
Failed

\SYMBOL 183 \f "Symbol" \s 12 \h
Not attempted

\SYMBOL 183 \f "Symbol" \s 12 \h
Incomplete




In any logic statement, a structure element may be made equal to any of these statuses.  However, if not explicitly identified these five statuses are resolved into two statuses: complete or incomplete as follows:


(
Complete

· Passed

· Completed

(
Incomplete

\SYMBOL 183 \f "Symbol" \s 12 \h
Failed 

\SYMBOL 183 \f "Symbol" \s 12 \h
Not attempted 

\SYMBOL 183 \f "Symbol" \s 12 \h
Incomplete 




In a prerequisite record the following statement




"A4","A1 & A2 & A3"




Means that the status of lessons (assignable units) 1, 2, and 3 must be Complete before the student can begin lesson 4.  That is, the student must achieve a pass or completed in lessons 1, 2, and 3 as prerequisites before he can take lesson 4.




In a prerequisite record the following statement




"A4","A1 = P & A2=P & A3 = P"




Means that the status of lessons (assignable units) 1, 2, and 3 must be Pass before the student can begin lesson 4.



A.5.2
Logic Statements

tc "6.6.3  Logic Statements" \l 3




Logic statement

xe "logic statement"
A logic statement is a list of course elements (block, assignable unit, objective) with their status (Complete, Incomplete, etc.) separated by logic operators (&, |, ~ ).  A special logic statement is the single word "never".  This is used to prevent a student from ever entering the lesson in the mode (normal, review, browse) for which the record is applicable.



Logic operators

xe "logic operator"
A logic operator describes how course elements are to be combined to determine whether a logical prerequisite is complete or incomplete.  This table lists the available logic operators.



Operator Meaning
Symbol


and
&


or
|


never
never


not
~


group or set
{  }


separator for set members 
,


complete X number out of a set
X*{  }


evaluate first
(  )

Definitions


When evaluating course elements in a logic statement, and status is not explicitly stated, one of two states is possible: complete or incomplete.
  These correspond to the traditional logical values of true and false.  The following operators can be used to create a logical statement with course elements.



xe "AND logic operator"
xe "& logic operator"
and
All elements separated by an & must be compete for the expression to be evaluated as complete.

A34 & A36 & A38
Assignable units number 34, 36, and 38 must all be complete for the group to be considered complete.



xe "OR logic operator"
xe "| logic operator"
or
If any of the elements separated by an | are passed the expression is considered true.

A34=P | A36=P | A38=P
If any one of the lessons, 34, 36, or 38, are passed then the group is considered complete.



xe "NEVER logic statement"
never
Special statement.  When the second field in a prerequisite file has “never”, then the third field identifies the mode in which the course element in the first field may not be used or entered.

A34, never, R
Assignable unit 34 may not be entered in the Review mode.



xe "not logic operator"
xe "~ logic operator"
not
An operator that returns incomplete (false) if the following element or expression is complete, and returns complete (true) if the following element or expression is incomplete (false).

A34, ~A35
The student may enter unit 34 as long as unit 35 has not been completed (that is, the status of A35 must be Incomplete, Failed, or Not attempted).  If assignable unit 35 is complete, the student may not enter unit 34.



xe "sets in logic statement"
xe "{  }"
set
A list of course elements separated by commas and surrounded by curly brackets -- {  }.  A set differs from a block, in that the set is defined only for purposes of the prerequisite file.  A set has no effect on the structure of the course.

{A34, A36, A37, A39}
Assignable units 34, 36, 37, and 39 are part of a set.




separator
The comma is used to separate the members of a set.  Each member of the set can be evaluated as a Boolean element – complete or incomplete.

{A34, A36, A37, A39}
Assignable units 34, 36, 37, and 39 are each separated by a comma in this set.



xe "X* logic operator"
X*
X is an integer number.  This operator means that X or more members of the set that follows must be complete for the expression to be complete (true).

“A38”, “3*{A34, A36, A37, A39}”
Any three or more of the following units – 34, 36, 37, 39 -- must be complete before the student can enter unit 38.



xe "(  )"
evaluate 1st
The expression inside the parenthesis (  ) must be evaluated before combining its results with other parts of the logical statement. Parentheses may be nested.

“A39”, “A34 & A35 | A36”

In this statement, completing A36 all by itself enables the student to enter A39.

“A39”, “A34 & (A35 | A36)”
Adding the parenthesis, makes it necessary to complete at least two units (A36 all by itself is no longer enough) to enter unit A39.



Examples


These records are from prerequisites files.



Level 3

A31,A23 & A28




Means that before the student can begin Assignable Unit #31, he must complete units 23 and 28.  This record



Level 3

"A31","3*{A23 , A25 , A26 , A28 , A29}"




Means that before he begins unit 31, the student must complete at least three of the five lessons listed in the parentheses.



Level 3

"A31","3*{A23 , (A25 & A26) , A28 , A29}"




In this case units 25 and 26 together comprise one member of the set.  Therefore, the student may have to complete 4 units in order to enter lesson (assignable unit) number 31.  For instance, having completed A23, A25, and A28, he would NOT be able to enter lesson 31.



Level 3

"B31","~J31"




Means that he may begin any unit in block 31 if he has not completed objective 31 (that is, if Objective 31 has a status of Incomplete, Fail, or Not Attempted the student may begin Block 31).  After completing objective 31, he may not enter block 31.



Level 3

"B31","~(J31=F)"




Means that he may begin any unit in block 31 if he has not failed objective 31 (that is, if Objective 31 has a status of  Fail, the student may not begin Block 31).  After failing objective 31, he may not enter block 31.

Level 3

A15, A14 & ~J15




Means that before he begins unit 15 the student must complete unit 14 and not have completed objective 15.  If he has mastered objective 15 he may not enter lesson 15.  If he has not completed lesson 14, he may not enter lesson 15.

A.6. Completion Requirements File

tc "6.7  Completion Requirements File" \l 2



File justification
While lesson and objective status is frequently determined within the lesson by the logic designed into it, this is not always true.  For instance, there may be an assignable unit designed to pre-test the student.  By demonstrating mastery of some objectives in this pre-test, the student may get credit for passing parts of a lesson – or even a complete lesson – without ever having seen it




In other words, the CMI system may sometimes determine the status of a element by factors outside the element itself.  Similarly  block and complex objective status is defined in terms of other structure elements.  Therefore, block and complex objective status must be determined by the CMI system.




The Completion Requirements file is designed to allow the explicit specification of when an assignable unit or block should be assigned a specific status; when that status does not conform to the defaults.  It is essentially an exception file.

Default status
Block
Block status is determined by the status of all of its members.  Unless specially defined in a completion requirements file, a block is considered complete when all members of the block are complete.


Lesson
Lesson status is determined by the lesson when the student leaves the lesson.  Additionally, a pass or fail status can be determined by the CMI by comparing the lesson’s score with the lesson’s mastery score.

File type
Table  (Comma-delimited ASCII)



File name
xxxxxxxx.CMP

The extension for this file is CMP.  Any legal eight characters may be used for the primary file name.



Records
Each record in this file defines how the CMI system may determine the status of an assignable unit or block.  




There may be an unlimited number of logic statements to determine the status of each lesson.  For instance, just to define Pass, Fail, Complete, and Incomplete for a single lesson would require 4 completion records.




The order of these records is significant.  To determine the status of a lesson, the CMI system should evaluate each statement relating to the lesson in the same order in which it appears in this file.  The first statement to evaluate True determines the status of the lesson.




It is important that the order of these records be respected by the CMI system during the import and export of the Completion Requirements file.



Fields 
Each record has three parts (fields).  These fields may be in any order.  The first record identifies the order with the field titles: Structure_element, Requirement, and Result.

STRUCTURE_ELEMENT: This field contains the exporting-system generated ID of an assignable unit, block or objective.  

REQUIREMENT: A logic statement that enables a true or false decision to be made by the CMI system.  The logic notation is the same as described in Section A.5.




RESULT: This field indicates the status of the element when the requirement statement is found TRUE.  This does NOT mean that if a PASS is in the result field and the requirement statement is false, then FAIL must be assumed.  If the requirement statement evaluates as FALSE, the status of the element is determined by other factors – either an additional completion record or default.



Example records
The records below are extracted from the beginning of a hypothetical file.






Level 3 or 4

“Structure_Element”, ”Requirement”, ”Result”

"B8", "A14|  A15| A16",”Complete”




Block 8 is considered complete when any one of these three assignable units is complete or passed.



Level 3 or 4

“Structure_Element”, ”Requirement”, ”Result”

"B21", "3*{A36 | A37 | A38 | A39 | A40}", “Complete”




This tells the CMI system that the block is complete when any 3 of these 5 assignable units is complete or passed.  An example of when this might be useful would be in a block with 5 exercises.  The course designer wants the student to perform at least 3 of the five exercises.  That is what this logic statement is indicating.



Level 3 or 4

“Structure_Element”, ”Requirement”, ”Result”

"B13","A8=P | A9=P | A10=P | A11=P", “Incomplete”

"B13"," A8=P & A9=P & A10=P & A11=P ", “Complete”




Notice that in this case, Block 13 will never be considered Complete.  The first statement will always evaluate True before the second.  And the first statement to evaluate True determines the status of the course element.



Level 3 or 4

“Structure_Element”, ”Requirement”, ”Result”

"B13","A8=P & A9=P & A10=P & A11=P ", “Complete”

"B13","A8=P | A9=P | A10=P | A11=P", “Incomplete”




This corrects the problem in the example above.  Now, as soon as the student has passed a single lesson in the block the block status will be changed from Not attempted to Incomplete.  When the student has passed all of the lessons, the status of the block will change to Complete because the first statement will evaluate True and the CMI system will never get to the second statement to re-evaluate the Block status.

Level 3 or 4

“Structure_Element”, ”Requirement”, ”Result”

"A14", "A3=F",”Fail”




Lesson 14 is considered Failed, if Lesson 3 (probably a pre-test) is failed.

A.7. Course Layout File

Description
This file contains layout information of the course.  From this information, the last seen display state of the course in the main work area can be recovered. 



File type
Up to the developer.  It can be just a binary file, XML file, etc.



File name
xxxxxxxx.LYO

The extension for this file is LYO.  Any legal eight characters may be used for the primary file name.



Appendix B. Windows INI File Formattc "4.3  MS Windows INI Files" \l 2




This file structure is based on the Microsoft WINDOWS *.INI files.  The INI file contains three types of data -- group, keyword, and comment.  The structure of the file and these data types are discussed in the following sections.



B.1
File Structure

tc "4.3.1  File Structure" \l 3




3 types
Each item in the file is one of three types -- GROUP, KEYWORD, or COMMENT.  These are defined in Section Appendix B. 



Naming rules


Group and keyword names are case insensitive.  The names may include alphanumeric characters and the underscore character, but may not include spaces.xe "name, group or keyword"

xe " keyword name"

xe "group name"



Group names are left justified and surrounded by brackets.  Keywords are left justified and followed by an equals sign ( = ).  Comments are lines whose first character is  a semicolon.



Appearance in file
Element name

 

[group] #                                                          keyword=parameter#                                        ;  groups and keywords

;  may have comments                             
Group

Valid Keyword

Comment







The # in this table means CR LF (0x0A 0x0D) (carriage return, line feed).  Comments must always be on a separate line from group names and keywords.



Limitation
The maximum number of characters allowed in an INI file line is 254.



Example
This file was created by a Lesson to pass information to a CMI system.





[CORE]

LESSON_STATUS = Passed

LESSON_LOCATION = End

SCORE  =  87

TIME   =  00:25:30

; this is the core group of data

; this is the lesson performance data 

; for a passed lesson that required a

; time of 25 minutes, 30 seconds and

; a score of 87



B.2
Comments

tc "4.3.2  Comments" \l 3




Definition

xe "comments"
Comments are text that is of use to a human viewing a file.  They are essentially invisible to a computer processing the data in the file.  No action is taken by the processor as a result of comments.



Format
First character in the line is a semicolon.  All characters following the semicolon, up to and including the carriage return are considered part of the comment.



Usage rules
Comments may appear anyplace in any order in the file.  Comments are only possible in INI files, they are not available in the Comma Delimited table files.



Example




; Comments can appear before

[CORE]

;  and after group names.

;  Comments can also appear before

SCORE  =  87

;  and after keywords.

TIME   =  00:25:30

;  Their existence has no impact on the

;  processing of the file.



B.3
Groups

tc "4.3.3  Groups" \l 3




Concept
Groups provide a mechanism for dividing a file into manageable segments that are more easily accessed by data retrieval routines.  They also provide a means to organize a file of data into logically related parts.  This is helpful for human-processing of a file as well as computer processing.



Definition
Groups are logically related assemblies of data items, generally several lines in length.  A group extends from its group identifier to the next group identifier, and may include multiple lines. Although groups may contain keywords, they may not contain other groups.




All carriage returns and symbols between group identifiers may be significant, depending on the definition of the specific group.  However, if a group contains keywords, then blank lines and extra carriage returns are ignored.  



Format
A group is identified by its name enclosed by square brackets.  The left bracket is at the far left margin, or preceded by spaces or tabs.  It cannot be preceded by any other characters.  It cannot be embedded in a line of information. The name is case insensitive.




Spaces: The name must be an alpha-numeric string with no spaces, inside square brackets.  There should be no spaces either preceding or following the name – in other words, no spaces should appear between the brackets.



Usage rules
Groups may appear in any order.  Although groups may appear multiple times in the file, only the first occurrence of the group is meaningful.




Group name examples:


[comments]


[OBJECTIVES_STATUS]


[student​_demographics]



Document convention
When a group name appears in this document it is identifiable for one of two reasons:

1)  It is surrounded by brackets, for example:

[Objectives_Status]

[COMMENTS]

[student_data]

2)  It is accompanied by the word "group", for example:

the Objectives_Status group

group COMMENTS

student_data group



B.4
Keywords

tc "4.3.4  Keywords" \l 3




Definition
Keywords are names of data items that are limited in size to a single line.  This generally limits the data to 60 or 70 characters.  The data items associated with a keyword are referred to as keyword arguments or keyword values.xe "argument, keyword"

xe "value, keyword"

xe "keyword argument"

xe "keyword value"


Format
Keywords appear at the left-hand margin followed by an equals sign.  Spaces before and after the equals sign are ignored. Keywords are case insensitive.



Keyword extensions

xe "keyword extension"

xe "extension, keyword"
Each keyword within a single group must be unique.  If keywords are duplicated, only the first one is taken into account.  To avoid duplicates, when there are multiple instances of a keyword inside a group, each keyword in the group has an extension.  Keyword extensions consist of a period and a simple two digit number, 00 through 99.



Example
An examples of a group with multiple instances of a keyword requiring an extension is the [Objectives_Status] group.  It has multiple objective ID's and a different status for each objective recorded in the group 





[Objective_Status]

J_ID.01= AB112

J_Status.01 = Pass

J_ID.02= AB124

J_Status.02 = Pass

J_ID.03= AB196

J_Status.03 = Fail



B.4  Keywords (cont.)

Argument format
The first non-space character after the "=" identifies the beginning of the data. Capitalization and spaces in the keyword data may or may not be significant, depending on the definition of the data associated with a specific keyword.




Examples:


Student_ID = JQH2142


OUTPUT_FILE=C:\STURECS\JQH2142.DTA



postal_code = 98124-2207



Usage rules

xe "keyword usage rules"
Blank lines between keywordsxe "blank lines between keywords" are ignored.  Keywords are always members of a group, although there may be groups without keywords in them.  An example of a group without a keyword is the [COMMENT] group.



Keyword order

xe "keyword order"

xe "sequencing keywords"

xe "order of keywords"
The order in which the keywords appear within any group is irrelevant.  In this document, they are ordered alphabetically for the convenience of the reader.  However, it is important that the keyword appear within its proper group.




Sometimes the same  keywords are used in different groups.  For instance, in the same file there is a group called LESSON_DATA with a keyword ID, and a group STUDENT_DATA with a keyword ID.  Obviously, these ID's are both different.  They can only be different by being members of a different group.




Like group names, keyword names may only appear once.  If  there are multiple occurrences of the same keyword, only the first one is significant.



Document convention

xe "keyword identification"
When a keyword name appears in this document it is identifiable for one of two reasons:

1)  It is followed by an equals sign, for example:

Score=

TIME=

max_time_allowed=

2)  It is accompanied by the word "keyword", for example:

the score keyword

the keyword Max_Time_Allowed

time keyword



Appendix C. Comma Delimited ASCII

tc "4.4  Comma Delimited ASCII" \l 2

xe "comma delimited file"



File flexibility
Data stored in a comma delimited ASCII file can be imported easily into virtually any off-the-shelf database product or spreadsheet.  Many programs use this format to exchange data.




This format is more than just a text file that is saved in ASCII form.  Comma delimited format supplies a simple mechanism for separating records and fields, and for distinguishing data types.




Though some systems and applications may support delimiters other than a comma, AICC files of this type require the use of a comma as a separator.



Records and fields
The format requires division of the data into records and fields.  The record is the data found on a single line.  The field is the data that is found between commas (comma delimited) on the line.  There is no fixed length for each field, and there is no fixed length for the records in the file.



Critical characters
There are certain characters that are important in this file format.  The format does not allow carriage returns within a record, double quotes     ( " ) within any field, or commas within a number field.  In this format, carriage returns, double quotes, and commas are interpreted as record or field delimiters.  However, you can use commas and single quote marks  ( ' ) within text field (fields delimited by double quotes).



Embedded carriage returns

xe "embedded carriage return"

xe "carriage return, embedded"
One unique addition to the standard comma delimited ASCII file is supported by this standard -- embedded carriage returns.  Since 

each field may be up to 254 characters in length, it may be desirable to indicate where carriage returns are to be placed.  Embedded carriage returns are indicated by the characters "<CR>".

When fields with the embedded <cr> are placed by the CMI system into a file in the INI format, the <cr> should be passed as an actual carriage return.  This enables a single field to contain several lines of group-

fields to contain group-keyword data that otherwise could not be held in a single field.



Tables and files
Notice in the example table below, there are labels for each column.  Each entry in a column corresponds to a field.  Each row in the table corresponds to a record.  In the conversion of this table to a comma-

comma-delimited file, the name of each field 

is gone.  Only the field data itself is in the file.only appears once, in the first record, at the top of the table.




Notice also, that empty field, or blank fields may have to exist in the comma delimited file.  In the third record there are two blank fields.  The first is an empty number field, and the second is an empty text field.  This is true because all records, or rows, in a file must have the same number of fields.



Usage rules
Some files will have different numbers of meaningful data elements in each record.  This means that records with fewer members must be padded with blank fields at the end of the record, so that all records have the same number of fields as the record with the most members.

This is necessary for some off-the-shelf database and spreadsheet products to import a comma-delimited file.




Notice the first record in the file.  It identifies the name of each field.  This identifies the order of the fields in any single file.  Two files with exactly the same contents would not have to have the fields in the same order.  The first record will always identify the order of all the fields to follow.




In the examples below the first field in the first file is “Lesson_ID”.  The first field in the second file is “Lesson_File_Name”.  The order in which the fields appear is different, but the content is the same.  The CMI system must be able to interpret the two files, and determine that the information in each is the same.



Example Table

Lesson ID
Title
Type
Max Score
Max_Time_Allowed
Lesson

File Name

777APU-1
Auxiliary Power Unit
Tutorial
38
00:18:00
APU.EXE

777EL-1
Electrical Power, Part 1
Tutorial
41
00:23:00
ELEC1.EXE

777EL-2
Electrical Power, Part 2
Practice


ELEC2.EXE

Comma Delimited File with Same Contents



“Lesson_id”,”title”,”type”,”Max_Score”,”max_time_allowed”,”lesson_file_name”

"777APU-1","Auxiliary Power Unit","Tutorial",38,"00:18:00","APU.EXE"

"777EL-1","Electrical Power, Part 1","Tutorial",41,"00:23:00","ELEC1.EXE"

"777EL-2","Electrical Power, Part 2","Practice",,"","ELEC2.EXE"



Second Comma Delimited File with Same Contents



”lesson_file_name”,“Lesson_id”,”title”,”type”,”Max_Score”,”max_time_allowed”

"APU.EXE","777APU-1","Auxiliary Power Unit","Tutorial",38,"00:18:00"

"ELEC1.EXE","777EL-1","Electrical Power, Part 1","Tutorial",41,"00:23:00"

"ELEC2.EXE","777EL-2","Electrical Power, Part 2","Practice",,""



Differences between INI and Table files


The following table summarizes some of the differences between the Keyword/Group file (sometimes called an INI file) and the Comma-Delimited Table file.




Keyword/Group
Table

Smallest unit of data
keyword
field

Size limit for smallest unit
60 to 70 characters (one line)
256 characters

Frequency that the unit’s name appears in file
keyword name appears every time a keyword is used
field name appears only once, at beginning of file

Number of small data units in a line of data
one keyword per line
many fields per line

Largest unit of data
group
record

Number of lines allowed for large unit of data
each group can have many lines
only one line per record

Maximum size of one line of data
80 characters
unlimited (many times 256)

Appendix D.  Version Change Log

D.1. Version 1.0 to 1.1

Location: 
section 7.1.3
Original:
Custom commenting requirements

Change:
Use javadoc guidelines for commenting. 

Location: 
section 9.4

Original:
Testing Requirements

Change:
Testing requirements are moved into a separate Test Specification document.

Location: 
section 6

Original:
Wizard Specifications

Change:
Removed and Place in Part 2 of the specification.

Location: 


Original:
Optimal Layout Tool

Change:
Removed and Place in Part 2 of the specification.

Location: 


Original:
Documentation Requirements

Change:
Removed and Place in Part 2 of the specification.

Location: 


Original:
Course Display Bean

Change:
Removed and Place in Part 2 of the specification.

D.2. Version 1.1 to Version 1.2

Location: 
section 3.1
Original:
Memory requirements mandatory

Change:
It is now a memory usage target.  If it can not be achieved, you should document why.  Section 4.6.2 discusses how to document it.

Location: 
section 4.6
Original:
Performance requirements mandatory

Change:
It is now a performance target.  If it can not be achieved, you should document why.  Section 4.6.1 discusses how to document it.
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//Title:        Course Builder


//Version:      


//Copyright:    Copyright (c) 1998


//Author:       John Yin


//Company:      Training Software LLC


//Date:	   8/3/1998


//Description:  ...


//Related Classes: @see CMI.courseComponent.CourseBuilderImpl





public class AlarmEvent extends EventObject {


  public String toString() { return “Alarm!”; }


  ...other functions... 


}





public interface AlarmEventListener extends EventListener {


  public void alarmOccurred(AlarmEvent e); 


}





class Clock {


  private Date currentTime;


  private Date alarmTime;





  public void setCurrentTime(Date d) { currentTime = d; }


  public Date getCurrentTime(Date d) { return currentTime; }


  public void setAlarmTime(Date d)   { alarmTime = d; }


  public Date getAlarmTime(Date d)   { return alarmTime; }


  public addAlarmEventListener(AlarmEventListener l);


  public removeAlarmEventListener(AlarmEventListener l);


  public void resetClock();     


}








class A {


  boolean checked;





  boolean isChecked() { return checked; }


  void setChecked(boolean c) { checked = c; }


}





Instead, you should do the following:





Class A {


    public int i;


}





A a = new A;


a.i = 1;








Class A {


    private int i;





    public int getValue() {


return i;


    }


    public int setValue(int value) {


	i = value;


    }


}





A a = new A;


a.i = 1;
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�   These Boolean statuses are defined  in the section titled “Assignable Unit and Objective Status” on page � PAGEREF complete_def �95�.


�   Operator precedence is the same as in the C programming language – including the use of parenthesis.


�   Quotation marks are not required in a comma delimited data file unless there are commas in one of the fields. However, quotation marks are commonly used around all fields for the sake of consistency.


�   In this record, quotation marks are required.  Otherwise, the commas separating set members would be interpreted as field separators.
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